
USER MANUAL
For

VisionSuite
Version 3.1





Hamilton Digital Designs Ltd.

Copyright © 2007

June 2007

Document Revision 1.00

Ref #: MN06002B





TA B L E  O F  C O N T E N T S

Introduction......................................................................................................................................  1
A brief description of the VisionSuite applications.

Getting Started.................................................................................................................................  5
A 10-Step process for setting up a sign and getting a simple message
playing.

Vision Setup ..................................................................................................................................  11
A detailed description of how to setup, test, and maintain a sign.

Vision Edit......................................................................................................................................  41
A detailed description of the use and features of the pixel-by-pixel bitmap
editing package.

Vision Quick Text ...........................................................................................................................  63
A detailed description of the use and features of the row-by-row text editor
application.

Vision Schedule .............................................................................................................................  75
A detailed description of the use and features of the drag & drop
scheduling application.

Vision Setup Wizard.......................................................................................................................  89
A detailed description of the use and features of wizard-based setup
application.

Vision Update ................................................................................................................................  93
A detailed description of the core application for sending schedules and
messages to a sign.

Vision Step2Sign Wizard............................................................................................................... 103
A detailed description of how to use the wizard that allows a simple 3-step
approach for creating messages and a schedule, and to update a sign.

Vision Instant Message Lite........................................................................................................... 121
A detailed description of the application used to display messages
“instantly” on a display.

Vision DVD ................................................................................................................................... 129
A detailed description of the application used to play DVDs on a Video
System.

Vision File Converter..................................................................................................................... 133
A detailed description of the application used to convert MSG files to VED
files.

Vision Quick Text Converter.......................................................................................................... 137
A detailed description of the application used to convert old Quick Text
files to new Quick Text files.



Vision Server ................................................................................................................................ 141
A detailed description of the application used to interface with networked
computers to play content on a Video System.

Vision Viewer ................................................................................................................................ 145
A detailed description of the application used to play content on a Video
System.

Vision Viewer Updater................................................................................................................... 149
A detailed description of the application used update and schedule
content on a remote computer attached to a Video System.

Appendices ..................................................................................................................................153

Recommended Computer System ...........................................................................................153
Advanced Topics .................................................................................................................... 155
Error Codes ............................................................................................................................ 159



OV E R V IEW

Version 3.1 1

OVERVIEW

The VisionSuite application and subsequent applications
have been developed for ease of use and ease of
manageability for your message or video sign system.

Your sign, whether it is a small mono-colored message
center or a large multi-colored video system (or something in
between), can be controlled, configured and maintained via
the applications within the VisionSuite. Depending upon your
sign’s features, you can use many or all of the applications on
most Windows™ based computer systems. (See
Recommended Computer System for more details.)

The main VisionSuite window is shown above. As you move
your mouse over the buttons or change the selection within
the list, the information region to the right portion of the
window updates.

The list to the left contains the applications that are available to you. The four buttons at the bottom of the window are
the HTML Help, the Tutorial, the Options Dialog, and Exit.

The Options dialog allows some minor customization for the
main VisionSuite application.

By changing the pull-down list, you can select the
applications that appear in the main window’s list.

The “Custom” selection allows you to specify the exact
applications that you see within the main window.

For a basic understanding of how VisionSuite works, follow
the step-by-step explanations within the Tutorial. It will guide
you through the process of setting up a sign to sending a new
schedule to a sign.



Overview VisionSuite User Manual

2 Version 3.1

THE APPS

As stated, VisionSuite is a series of applications that are
designed to make the process of designing messages,
developing a schedule, and updating a sign as easy as
possible. Due to the various requirements of our customers, it
was decided to develop a variety of applications to meet the
variety of needs.

Here is the current list of applications for VisionSuite 3.1:

Vision Edit  – An application for pixel-by-pixel control of an
image for message design. Bitmap & Text control, importing,
and effects are available.

Vision Quick Text  – An application for row-by-row text
control message design. Unique text control on a row-by-row
basis exists with full frame effects control.

Vision Schedule  – An application for pick-and-place
scheduling of messages. Special graphical time/date control
and view of messages allow for ease of use and quick setup of a schedule.

Vision Update  – An application for the update of schedules and messages to any selected sign. The new Batch
Control permits updating of multiple signs at any specified time.

Vision Setup  – An application for the control and maintenance of displays. Special tools are available for
communication tests and sign diagnostics.

Vision Step2Sign Wizard  – A step-by-step wizard for message design, schedule design, and updating a sign — an
all-in-one application.

Vision Instant Message Lite  – A special application designed for use within sport venues. This is a package with
message library control and instant message display on the sign.

Vision Quick Text Converter  – A converting tool to convert older Vision Quick Text files into newer versions.

Vision Setup Wizard  – An application to easily set up the most common types of displays.

Vision DVD  – An application for playing DVDs on a Video System.

Vision File Converter  – An application to convert MSG files to VED files.

Vision Viewer  – An application to display content on a Video System.

Vision Viewer Updater  – An application to update content on a Sign PC to which a Video System is connected.

Vision Server  – An application running on a Sign PC that accepts requests from Remote PCs running Vision Viewer
Updater.

HISTORY

The VisionSuite 1.0/1.1 tools were developed in 2002/2003 for the Hamilton Digital Designs (hereinafter will be
referred to as HDD) product line of signs. It is a software replacement to all standard versions of the DOS H1020
software.
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For 2004, version 2.0/2.1 tools were enhanced with improved interfaces and faster communication to/from the sign.
Besides the enhancements and improvements of the applications, version 2.0/2.1 of VisionSuite offered a new wizard
to facilitate basic needs of some customers.

For 2006/2007, version 3.0/3.1 tools have been enhanced with faster communications, easier to use interfaces, and
more features for the brand new multi-shaded signs.

BACKWARD COMPATIBILITY

The VisionSuite tools have been designed to be compatible with the following HDD signs: all New Signs, all H21
Controller based Message Centers, and all H20 Controller based Message Centers (connection via modem only).
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INTRODUCTION

"Getting Started" will take you through 10 simple steps  from setting up a new sign to updating the messages at the
sign. Once the steps are completed, you will have updated the sign with new messages.

It is assumed that the VisionSuite software has already been installed onto the computer. If the sign has not been
installed yet, you can still follow the steps to setup a new sign.

These steps also assume that the sign is a standard Message Centre display with an RS-485 connection to the PC,
with a Temperature/Photocell, and a matrix size of 80 x 16 (pixels).

STEP 1: START VISIONSUITE

When starting VisionSuite for the first time, the following
message will appear. The message simply indicates that you
need to setup (configure) a sign so that you can use the
applications within VisionSuite

Select Vision Setup  from the main window (within the left-
side list) and then double-click the mouse to start Vision
Setup.
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STEP 2: STARTING VISION SETUP

When Vision Setup starts for the first time, it will appear blank
(as shown).

Simply select New Sign  from the File Menu at the top left of
the window.

 

 

 

 

 

 

 

 

 

STEP 3: ENTER GENERAL DATA FOR THE SIGN

When setting up a sign, there are a few basic parameters that
need to be entered.

The Sign Name  and the Type of Sign  are required items.
For a standard Message Centre that has multiple shades,
select Vision MAX - H22, otherwise, select Vision MAX - H21.
For this example, it will be assumed that you selected Vision
MAX - H22.

The Location  and Notes  section exist to allow you to clarify
the sign's location and/or settings.

Once completed, select the Communications item (in the list
on the left).
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STEP 4: ENTER COMMUNICATION VALUES

There are a wide range of connection possibilities from the
PC to the sign.

For this example, it will be assumed that the sign is wired
from the PC via a long cable and an RS-485 converter.

The Port  refers to the serial port on the PC that the converter
is connected to. For this example, assume that it is COM1
and that the Baud Rate  is 115.2 kB.

The Address  refers to a setting within the sign. For now,
assume that it is ZERO.

Once completed, select the Settings item on the left.

 

 

STEP 5: ENTER MATRIX SIZE AND SETTINGS VALUES

For this example, let's assume the sign is 80 pixels wide and
16 pixels high. This is also referred to as the sign's matrix.

As mentioned earlier, let's set the Color  setting to Mono
Red: 256 Shades .

Once completed, select the Intensities item on the left.
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STEP 6: ENTER INTENSITY VALUES & APPLY

As mentioned earlier, let's assume that the sign has a
Temperature/Photocell probe. This device allows the sign to
automatically adjust its intensity when it gets dark. So, select
Automatic  and leave the percentages to default values.

Once completed, select the Apply  button at the bottom. This
will save the sign that has just been setup. The software will
prompt you with a simple message that indicates the sign is
now saved.

Press OK within that message and OK again within the New
Sign window.

 

 

 

STEP 7: UPDATE SIGN PARAMETERS

If the sign is attached to the PC and powered on, then Vision
Setup will automatically try to connect to it.

Once connected, the sign's parameters may need to be
updated. If there is a COMPARISON section appearing within
the Status  list, then these parameters are different than what
is set at the sign. It is important to update the sign.

To udpate the sign, go to Actions, then Options, then Update
All Parameters. Press the Update  button in the Update
Parameters window.

 

 

 

 

 

 



User Manual VisionSuite Getting Started

Version 3.1 9

STEP 8: VERIFY COMMUNICATIONS

If the sign is attached to the PC and powered on, then it's
recommended that you test the connection to the sign.

From the main Vision Setup window, select the Test
Connection  button at the bottom-left.

Vision Setup will automatically perform continuous basic
communication tests to the sign. This verifies that the sign is
working properly and that the PC can communicate to the
sign.

Once completed, simply close Vision Setup.

 

STEP 9: GO TO VISION STEP2SIGN WIZARD

When Vision Setup closes, the main VisionSuite window will
open. From there, select Vision Step2Sign Wizard in the list
on the left.

Vision Step2Sign is a simple step-by-step application for
creating messages & schedules and updating a sign.

When it opens, simply select the 12 Hour Time.vmg  item in
the Common Messages and then press the Add  button. This
adds the Time message to the schedule. Also add the
Temperature  message to the schedule list.

Once completed, press the NEXT button at the bottom.

The next window is simply a SAVE schedule window. Press
the SAVE button. This will automatically step you to the next window.

STEP 10: UPDATE THE SIGN

When the "Update the Sign" step appears, Vision Step2Sign
will automatically connect to the sign. After it connects, the
SEND button will become available.

Press the SEND button. The messges and new schedule will
be automatically sent to the sign.

You can now close Vision Step2Sign.
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DONE!!!

You have successfully configured a new sign and updated the sign's messages and schedule.

ADDITIONAL INFORMATION

For further information about the applications, please refer to the User Manual or the Tutorial. The documents are
available in PDF format (for printing) or via HTML Help and Tutorial selections within the VisionSuite application.
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OVERVIEW

The Vision Setup application allows you to initially configure
the sign settings and to directly access the sign for diagnostic
& maintenance purposes.

Vision Setup is the first application that must be run after you
install VisionSuite. You must first configure a New Sign in
order for the other applications to be properly initialized. It is
also highly recommended to initially test your
communications to the sign.

VisionSuite is designed to work with many types of signs.
Therefore, it is very important to verify that you have setup
VisionSuite properly by ensuring that the sign communicates
with the VisionSuite applications.

Vision Setup is designed for setting up and maintaining both
Message and Video signs.

 

 

 

HOW VISION SETUP WORKS

When Vision Setup is used for the first time, the window will appear mostly blank and grayed-out. You can then use
the New Sign selection in the File menu to configure a new sign. Once created, you can then test the communications
to the sign and initialize the signs settings. The main window is designed to give you information about the sign and to
provide a means to diagnose and maintain your sign.

Nevertheless, once the sign is initially setup, you may not need Vision Setup’s capabilities. In most normal situations,
the default settings within the other communication applications (Vision Update, Vision Step2Sign Wizard, and Vision
Instant Message) will handle most basic maintenance requirements.

The menu items give you access to various functions to manage sign and to setup default settings.

To get a quick understanding of the basic features of Vision Setup, please review the Examples below or go through
the Tutorial.
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OPENING VISION SETUP

When either more than one sign has been configured for your
PC or with a specific application option set, you will see this
dialog each time you open a VisionSuite application.

Once the sign has been selected, Vision Setup will
automatically attempt to connect to the sign. When no signs
have been configured, a blank Vision Setup window will
appear with most items disabled. When the selected sign is
not available or OFFLINE, a normal window will appear
indicating that the sign is OFFLINE.

When CANCEL is pressed, the default blank Vision Setup
window will appear.

 

 

 

THE MAIN WINDOW (FIRST TIME)

When Vision Setup is open for the first time, there will be no
signs configured.

All of the regions within the main window will be grayed-out
and the title bar will not have a sign name shown.

You will need to enter a New Sign. From the File menu,
select New Sign. Below is a complete explanation of the New
Sign window.
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THE MAIN WINDOW (ONLINE)

When connecting to an ONLINE sign, the main window will fill
with the parameters from the sign. When initially connecting
to the sign, the Communication Status  region (the bottom-
right) will update with connection information.

There are several regions within the main window.

The Settings  region displays most of the information set
during the sign’s setup.

The Status  region displays the current information from the
sign. Within this region, there may be a Comparison section.
This will show any important differences between the settings
at the sign and those on the PC.

The Common Buttons  region which allows you access to a
variety of controls (Connect, Reconfigure, Test
Communications, Run Test Pattern, and Manage
Passwords).

The Communication Status  region shows connection
information.

Settings Region

The left side of the main window displays various items about the sign;
General Information, Sign Settings, Intensity Settings, Connection, and
Other Settings.

The various parameters and values shown within these sections
represent the majority of the main settings for the sign. These values are
read from a special file stored on the PC for the sign’s settings.

If the sign is setup properly, these settings should match the
corresponding settings stored at the sign.
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Status Region

The right side of the main window displays various active items at the
sign: Current State, Operational Time, and Comparison.

The Current State section displays the main items about the sign:

• The current schedule playing

• The current message playing

• The date and time setting at the sign

• The total memory available at the sign for message files

• The current version of the Operating System at the sign

• The current reading of the Temperature at the sign

• The current reading of the Photocell (used for automatic intensity
control)

 

 

 

The Operational Time section displays the amount of time left
for the sign before an Authorization Code must be entered.

Ten days  (and less) before the “time” expires, a message
box will appear whenever the user connects to the sign.
Once the time expires, the sign will no longer resp ond to
updates and the current schedule will stop running.

The Comparison section indicates any “differences” that may
exist between the settings on the PC and within the Sign’s
memory. The values that are evaluated are:

• Intensity

• Sign Size

• Color Control

• Temperature Offset

Common Buttons Region

There are several buttons in this region that give you access to different
features.

The Disconnect/Connect button (as the name indicates) allows you to
disconnect from a sign that is currently ONLINE and connect to a sign that
is not currently ONLINE.

The Reconfigure button allows you to change various settings within the
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sign’s definition file stored on the PC.

The Test Communications button allows you to run more complicated communication tests between the PC and the
sign.

The Run Test Pattern button runs a low-level test pattern at the sign. It will indicate if the basic operations and wiring of
the sign are working properly.

The Password button allows the setting of Hardware and Authorization passwords for the sign.

Test Communications

Pressing the “Test Communications” button displays the
dialog shown to the right. When the dialog opens, it
automatically begins transmitting test signals to the sign.

For proper communications, you should see a 100% pass
rate in the basic communications test. If you see more
than 10% failure, you should investigate why this is
happening. For more information on determining why you
might have a high failure rate in the communications,
please refer to the Troubleshooting section below.

 

 

Pressing the “Options” button within the “Test
Communications” dialog, will give you access to several
settings.

The “Number of Items to Save” is a number representing the
number of items recorded within the final report.

The “Type of Communication Test” states the type of test
used for the test. The selections are:

• Basic – Obtains simple status information about the
sign.

• Intermediate – Obtains the file folder information from
the sign. Depending on the number of files at the
sign, this can take far more time that the basic test.

• Advanced – Transmits a selected file to the sign and then deletes it at the sign. Large files should not
be used for this test.

When “View final test report” is selected, Vision Setup will produce a report on the communications test.

When “Allow comments to be entered…” is selected, you can add in a small comment to the end of the report.
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The comment can be of any length that you wish.

The final report that is made is an HTM file. This type of
file can be imported into such packages as Microsoft
Word™. The file (named TestComm.htm) is stored in the
main VisionSuite folder on your computer. The file is only
a temporary file and is replaced each time the Test
Communications report is generated. If you want to store
the file for later use, you can use the Save As  selection
under the File menu when you view the report. You can
also use Windows Explorer to copy the file to another
location on your computer.

Password

A Hardware Password  can be set by you (the user) in
order to add extra security to the sign. When the
password is set, it will have to be entered each time you
connect to the sign.

WARNING:  It is very important to record your passwords.
If a “Hardware Password” is lost, a Service Call may be
required to clear the password and restore normal
operations of the sign.

When clearing the password, you must first enter it with
the SET button. After the sign's electronic controller has
confirmed the password, you can come back to this
window to press the CLEAR button. The CLEAR button
will only be activated if the password has been confirmed
by the sign's electronic controller.

The Authorization Code  can be entered via the Actions menu.

When the “Set” button is pressed for the “Hardware Password”,
the dialog shown to the right appears.

Simply enter your password twice and press the OK button.
Upon return to the “Hardware Passwords” dialog, press the OK
button. The sign will now be set with the new Sign Password.

 

 

 

If the “Set” button is pressed for the “Hardware Password” when
the password has already been set (when the “Active” indicator
is shown), the standard “Password Entry” dialog is shown.

Simply enter the set password and press OK. Access will be
granted to the sign if the password is correct.
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If the “Clear” button is pressed for the “Hardware
Password” when the password has already been set
(when the “Active” indicator is shown), the dialog to the
right is displayed.

Press YES to clear the password.

NOTE: In order to clear the password, you must first
enter it with the “Set” button and press OK to inform the
sign that you have “permission” to change or clear the
password .

Communication Status Region

At the bottom-right of the main window is the Communication Status
region that indicates the current state of the connection between the
computer and the sign.

During the initial connection between the computer and the sign, Vision
Setup will obtain the sign’s parameters and file information. Depending
upon the link between the computer and the sign, this process can take
from a few seconds to a few minutes.

Error messages and other communication events are also displayed within this region. For a complete list of the
meaning of particular error messages, please refer to the List of Communication Errors.

During the transfer of files, the “Abort” button will be enabled and visible. By pressing the “Abort” button, the transfer of
the file and all subsequent events for the file transfer will be cancelled.

FILE MENU

The File menu gives you access to four items:

New Sign  allows you to create a new sign.

Select Sign  allows you to select a new sign. If you have several different signs, then
you can use this function to access the Sign Selection dialog. Once selected, Vision
Setup will disconnect from the current sign and reconnect to the new sign.

Print Summary  displays an HTML file with information about the sign. This file can be
printed to most standard printers.

Exit  closes Vision Setup.
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New Sign

The New Sign window has been totally redesigned from the
previous versions. On the left side of the window is a list of
sections. Each section allows access to a set of features that
can be adjusted.

Once the sign has been setup, press the Apply button to save
the values to a file on the PC. Afterwards, these saved values
will be used to update the sign itself.

The Summary button will produce a simple report showing
most of the settings for the sign. Cancel will return you to the
main Vision Setup window. OK will also return you to the
main Vision Setup window, but it will also automatically try to
connect to the sign.

WARNING:  Various settings can seriously effect the
operation of VisionSuite and the communications to the
sign. Please do not  change these values without a clear understanding of the settings.

New Sign – General

The General section contains the basic information about
the sign. You can set the following items:

• Name – The name of the sign should be
something clear and meaningful. It must be less
than 64 characters in length.

• Location  – The location is useful when more
than one sign exists. It can describe the general
location of the sign with respect to the other
signs. It must be less than 64 characters in
length.

• Notes  – The notes section is where you can
further describe the sign or the connection to the
sign. It must be less than 256 characters in
length.

• Type of Sign  – The VisionSuite software can connect with many different types of signs. This setting
describes how the software should communicate to the sign and what range of capabilities the
software should allow the user to have access to. DO NOT CHANGE this setting without instructions
from a qualified technician.

• Version  – This setting is a sub-setting for the “type of sign”. It further specifies the connection to the
sign. DO NOT CHANGE this setting without instructions from a qualified technician.
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New Sign – Communications

The Communications section contains the specifications
that describe how the PC is connected to the sign. This
section is split into three parts.

The top portion shows the five major connection
methods. The middle portion shows the various settings
possible for each connection method. The bottom portion
is a summary of the settings.

 

 

 

Standard Serial (RS232)

With a standard serial connection setting, one is normally
going through a short cable (less than 20 feet) directly to
the sign or to a converter. In addition, a standard serial
connection only has two settings: Port and Baud Rate.
The baud rate is limited to the type of sign that is being
used and the method of communications.

Serial converters come in many forms: RF Transceivers,
Ethernet Servers, USB, etc. These are only a small
sample of the converters available.

 

 

Industrial Serial (RS485)

With an industrial serial connection setting, one is
normally wired from the PC through a short cable (less
than 20 feet) to a RS485 converter and then a long wire
(less than 4000 feet) to the sign. An industrial serial
connection has three settings; Port, Baud Rate and
Address. The baud rate is limited to the type of sign that
is being used and the method of communications. The
address reflects a physical setting in the sign’s
electronics. This setting is used when there is more than
1 sign connected in a “RS485 Network” of signs. The
address designates one sign from another .
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Modem (General)

With a modem setting, one is normally wired from the PC
through a short cable (less than 6 feet) to an external
modem. The modem is then connected to the phone line.
At the sign, there is either a land-line modem or a cell-
phone modem. A modem connection has several settings
that define/control the modem at the PC and the
communication requirements for the type of modem at
the sign: Port, Baud Rate, Address, AT Mode, TAPI
Mode, and “More”. The baud rate is limited to the type of
sign that is being used and the method of
communications. The address reflects a physical setting
in the sign’s electronics. The AT and TAPI modes are two
different types of “processes” used to communicate
through a modem. The More button will allow you to
setup the various settings for each mode.

The AT mode refers to the use of AT commands for
setting up and processing modem communications. The TAPI mode refers to use of Windows’ Telephony API
for setting up and processing modem communications. Depending upon the type of modem, the version of
Windows, and the link to the sign, one mode may be better than the other.

For cell modem communications, it is recommended to use AT-Mode. It has been experimentally shown that
this mode works more reliably than the TAPI-Mode.

Modem – AT Mode

When setting up your connection with a modem in AT-
Mode, all you may need to do is enter the exact phone
number into the control as shown. Spaces and dash
marks are not needed. If you need to enter in a “9” to get
an outside line, you can enter it in here or within the “AT-
Command Settings” section.

The “Allow Automatic Connection” selection specifies that
the VisionSuite software can automatically connect to the
sign when the user selects the sign (within certain
applications). For instance, this can be very useful when
using the BATCH MODE within Vision Update.

There are several standard AT-Command Settings that
have been predefined. If you need to change the default
settings for your situation, then select Custom and
change the values.

When altering the AT commands for a particular modem
or phone system requirement, you should have exact
knowledge of the AT command or change that is required. If
you double-click on any AT Command setting, a dialog
similar to the one to the right will appear.

For a more detailed explanation of these settings, contact
Technical Support for assistance.
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Modem – TAPI Mode

In setting up a modem, the modem must be installed
correctly within Windows. If your modem does not appear
in the list in Step 1, then Windows does not recognize the
modem properly. Simply reinstalling the modem may
correct the problem. (Refer to Troubleshooting for more
assistance.)

Once the modem has been selected, set the country
code, the area code and the specific phone number that
the sign is located at. If more settings are required due to
your location, select the “Advanced Settings” button.

The “Allow Automatic Connection” selection specifies that
the VisionSuite software can automatically connect to the
sign when the user selects the sign (within certain
applications). For instance, this can be very useful when
using the BATCH MODE within Vision Update.

The “Advanced Settings” button will give you access to
the standard “Phone and Modem Options” dialog. This is
the standard dialog provided within Windows. This dialog
can also be accessed via the standard Windows’ Control
Panel.

You can setup any number of special settings for your
modem and the connection to the sign via this dialog and
the following 3 dialogs.

NOTE: The dialog shown to the right is specific to
Windows XP Pro. Yours may look slightly different due to
your version of Windows.
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Whether you press New or Edit, you will see a dialog
similar to the one shown to the right.

It is composed of 3 tabs. Some modems do provide
additional settings than the ones being shown.

The General tab allows you to setup parameters for your
current location. If you require a special number to gain
an “outside” line, you enter it in this tab.

 

 

 

 

 

 

 

 

 

 

Depending upon your location and the sign’s location,
you may require special Area Code rules. In some
places, the Area Code is dialed along with the normal
phone number even with local calls. If this is your
situation, you can set the number appropriately.
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Finally, some users may utilize Calling Cards (e.g. when
they are on-the-road with a laptop).

For proper settings, please contact your Internet service
provider and/or your local phone company.

For more information on these modem settings, please
refer to your Windows manual and/or the manual that has
come with your modem.

 

 

 

 

 

 

 

 

 

RF Transceivers

With an RF (or Radio Frequency) Transceiver connection
setting, one is normally wired from the PC through a short
cable (less than 6 feet) to a RF Transceiver and then a
wireless link (less than 10000 feet {dependent upon the
type of antenna used}) to the sign. The RF Transceivers
work as a pair of devices that must be in a Line of Sight
of each another. Depending upon the type of RF device,
the device can be affected by other wireless devices,
tinted windows, walls, trees, and weather (or
environmental) conditions.

An RF Transceiver connection normally has four settings;
Port, Baud Rate, Address, and Dynamic Linking. The
baud rate is limited to the type of sign that is being used
and the method of communications. The address reflects
a physical setting in the sign’s electronics.

The dynamic link is not available for VisionSuite 3.0.
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TCP/IP

With a TCP/IP connection setting, one is normally wired
from the PC through a network cable to the network of
the company. The sign or appropriate sign software is
also connected to the network. The sign or sign software
must be  behind the company’s Firewall protection
infrastructure.

A TCP/IP connection normally has two settings: Router
Port, and IP Address.

The TCP/IP is not available for VisionSuite 3.0 .

 

 

New Sign – Settings

The Settings section contains the specifications that
describe the sign’s size, color capability, and pairing. The
various items within this section are dependent on the
type of sign. Therefore, some items may not be
accessible.

The following items can be set in this section:

• Width  – The sign’s width in pixels (or columns).
The value must be greater than or equal to 8.

• Height  – The sign’s height in pixels (or rows).
The value must be greater than or equal to 7.

• Number  – The number of signs connected to the
sign’s electronic controller. This value should
normally be 1.

• Color  – This value is highly dependent upon the type of sign and the LEDs used during
manufacturing.

• Type  – This value is only for certain legacy systems.

• Mono Color Control  – With certain types of signs, the sign’s electronic controller can emulate RGB
color for certain types of Monochromatic sign configurations.

• Primary Controller  – This value indicates that the sign’s electronic controller is the main device in a
series of controllers.

• Multi-Mode Operation  – This value is normally used to specify that more than one sign share a
common communication link (such as a modem). When selected, the “Companion Signs” button
becomes enabled.

• Companion Sign  – This button allows you to specify the other signs that share the common
communication link.
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New Sign – Intensities

The Intensities section contains the specifications
required for controlling the intensity & contrast of the sign.
The various items within this section are dependent on
the type of sign. Therefore, some items may not be
accessible.

The following items can be set in this section:

• Manual/Automatic  – These control how the sign
adapts to light. When the sign has a “photocell”
device attached to it, this setting should be in
automatic mode.

• Daytime  – For the manual mode, this is the
requested intensity level. For the automatic
mode, this specifies the overall daytime intensity
level of the sign. The daytime intensity occurs
when the ambient light goes above the “threshold” value.

• Nighttime  – For the automatic mode, this specifies the overall nighttime intensity level of the sign. The
nighttime intensity occurs when the ambient light goes below the “threshold” value.

• Threshold  – The level that specifies when day and night values are used. Only available in automatic
mode.

• Contrast  – The contrast of light and dark intensities for the sign.

• RGB Overall Settings  – These control the overall intensity values for the red, green, and blue LEDs
within the sign.

• Panel Control  – Only available for qualified Service personnel.

New Sign – Timing

The Timing section contains the specifications for
controlling certain timing constraints in the
communication link from the PC to the sign. The various
items within this section are HIGHLY dependent on the
type of sign and the connection link. These items should
only be changed by a qualified Technician or with
instructions from Tech Support.

There is several default settings already predefined. If
you need to alter the settings, select “Customized” from
the pull-down list.
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When Customized is first selected, a dialog (shown to the
right) appears so that you can copy values from a specific
predefined setting or load it from a specific file.

 

 

 

 

 

 

Once selected, you can alter the timing parameter by double-
clicking on the entry within the list. The “Set Timing Parameter”
dialog will appear (shown to the right). Only the Setting parameter
can be altered.

 

 

 

New Sign – Operations

The Operations section contains a few parameters that
control how the PC connects to the sign and how the
user “sees” the sign within the software.

The following items can be set in this section;

• Synchronize  – This setting allow the sign to
have its internal timing reset every time the
schedule and messages are sent to the sign.

• Optimize  – This setting instructs the sign’s
electronic controller to optimized its file storage
memory compacted every time the schedule and
messages are sent to the sign.

• Restart Time  – This is the length of time for
various software applications to wait when the
sign’s electronic controller is restarted via software control.

• Log File  – When there are separate log files for each sign, this section allows you to specify the log
file name for the sign.

• Image File  – You can assign a bitmap file (BMP) to this specific sign. It can be a visual cue to which
sign you need to select within the Sign Selection dialog.
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New Sign – Offsets

The Offsets section allows control on the offset and
scaling of Temperature and Photocell readings at the
sign.

These values are dependent upon the type of sign and
the type of Temperature/Photocell Probe that is attached
to the sign .

 

 

 

 

New Sign – Wiring

The Wiring section is only available for certain type of
signs and can only be accessed with a password.

When accessible, there are 16 predefined “Wiring
Patterns” and 2 predefined “Module Types”. When
changing the Wiring Pattern, the image at the bottom-
right will update to show the type of pattern.

A custom wiring pattern can also be defined.

 

 

 

 

Exit

You can exit the application by one of two methods. First, you
can select “Exit” from the File menu. Second, you can press the
“X” (close) button at the top right of the application. In the
second case, a similar dialog as shown to the right appears to
ensure that you want to close. By purposely selecting the “Exit”
from the File menu, you can bypass this dialog.

 

 

VIEW MENU

The View menu gives you access various information.
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Previous “Test Communication” will display the results shown in the TestComm.htm file located in the VisionSuite
main folder.

Communications Log File will display the current log file. The Log file will only be generated if the Log Options is
enabled (see the Options section below for more information).

ACTIONS MENU

The first part of the Actions menu is basically identical to the buttons
at the bottom-left of the main window.

The Password & Code  submenu displays separate selections for
Hardware and Authorization password entry.

The Refresh  selection only updates the Status section on the main
window.

The Options  submenu displays more actions that may possibly be
performed upon the sign.

Actions - Password & Code

The Options selection shows an extended list of features for the
ONLINE sign.

• Hardware Password – Allows a user to set, enter, or
clear a password for the sign.

• Authorization Code – Allows a user to clear an
AuthorizationCode that has been set during
manufacturing.

Actions - Hardware Password

A Hardware Password can be set by you (the user) in
order to add extra security to the sign. When the
password is set, it will have to be entered each time you
connect to the sign.

WARNING:  It is very important to record your passwords.
If a “Hardware Password” is lost, a Service Call may be
required to clear the password and to restore normal
operation of the sign.

When clearing the password, you must first enter it with
the SET button. After the sign's electronic controller has
confirmed the password, you can come back to this
window to press the CLEAR button. The CLEAR button
will only be activated if the password has been confirmed
by the sign's electronic controller.
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When the “Set” button is pressed for the “Hardware Password”,
the dialog shown to the right appears.

Simply enter your password twice and press the OK button.
Upon return to the “Hardware Passwords” dialog, press the OK
button. The sign will now be set with the new Sign Password .

 

 

 

If the “Set” button is pressed for the “Hardware Password” when
the password has already been set (when the “Active” indicator
is shown), the standard “Password Entry” dialog is shown.

Simply enter the set password and press OK. Access will be
granted to the sign if the password is correct .

 

If the “Clear” button is pressed for the “Hardware
Password” when the password has already been set
(when the “Active” indicator is shown), the dialog to the
right is displayed.

Press YES to clear the password.

NOTE: In order to clear the password, you must first
enter it with the “Set” button and press OK to inform the
sign that you have “permission” to change or clear the
password .

Actions -Authorization Code

The Authorization Code  is used to add & remove a
“time limit ” to the sign. The time limit is normally set by
the manufacturer or Sign Company that you bought your
sign from. If the time limit expires, you will no longer
be able to update your sign .
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A warning message will be displayed 10 days  (and less)
prior to the expiration time. Before the time expires, you
should contact your Sign Provider for assistance.

 

 

 

 

When the “Set ” button is pressed, the “Authorization
Password ”dialog shown to the right appears.

Simply enter the “Authorization Password” (provided by
the Sign Company that you bought your sign from) into
the “Enter Password” control. Press the “Tab” key on
your keyboard to proceed to the next field. You must then
re-enter the password again. Press the “Tab” key again,
and the OK button will become enabled .

Press the OK button and then the OK button in the “Set
Hardware Passwords” dialog. The sign will then be updated.
The “Time Limit ” (or “Time Expired ”) entry will disappear.

When the AuthorizationCode is not entered properly or does
not match the one set in the sign controller, you will see the
warning message as shown to the right.

Actions - Options

The Options selection shows an extended list of features for
the ONLINE sign.

• Stop/Start Schedule  – Allows a user to stop and
start the schedule at the sign.

• Manage File  – This action will display a dialog to
allow one to view or delete the files at the sign.

• Toggle Video Inputs  – Allows a user to toggle a
video input for a video system remotely.

• Compact Memory  – Allows a user to manually
optimize the file system memory on a sign’s
electronic controller.

• Update Time  – Allows a user to manually update the time at the sign.

• Update Operating System  – This action transmits a copy of the operating system to the sign’s electronic
controller.

• Update All Parameters  – This action will transmit all of required settings for the sign’s electronic controller
(that are saved on the PC) to the sign.

• View All Live Settings  – This action allows the user to view the settings at the sign.
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• Advanced Features  – Depending upon the type of sign, certain advanced features are available.

Actions - Manage Files

The Files dialog allows you to view the files that are
current in the sign’s electronic controller’s file memory.

• File Structure  – The list of files at the sign
separated off by the type of file.

• System Memory  – Displays the total and
available memory at the sign.

• File Information  – Displays the size, data, and
time of each file at the sign. Some types of signs
do not display all of the values.

• Delete  – Allows you to delete a selected file.

• View  – Allows you to view a selected file. Not all
files can be viewed.

• Delete All  – Allows you to delete all files at the
sign.

• Print  – Produces a simple report of the file structure. The report can be printed or emailed.

Actions - Compact Memory

Normally, the operating system at the sign will
dynamically optimize the memory when it determines that
it’s necessary. However, you can force the operating
system to perform the memory optimization with this tool.

Depending upon the amount of memory in your sign, this
may take anywhere from a few seconds to several
minutes.

Actions - Update Time

The updating of the Time & Date at the sign is a simple
operation and does not affect the files at the sign.

The Time/Date that is sent to the sign is obtained from
the PC. If the clock (or time) on your PC is not working
properly, you should use a different PC to update the
time.
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Actions - Update Operating System

The updating of the OS (operating system) at the sign is
an advanced procedure and should only be done when
needed.

The sending of the OS to the sign can take several
minutes depending upon the connection link to the sign.
Once the OS has been sent and the sign parameters
updated (this process is automatic), the sign will reboot.
Depending upon the speed of the sign controller, Vision
Setup may see the sign go OFFLINE for a few minutes.
You can wait or restart Vision Setup.

Actions - Update All Parameters

This dialog allows you to view differences in the major
settings between the values at the sign and on the PC.

The displayed values will differ for each type of sign.

Press the Update button to update the sign. If the
software shows the sign as OFFLINE, you can either wait
for a few minutes or close Vision Setup.

 

Actions - View All Live Settings

This dialog only displays the settings and current status
of the sign. This is a complete list of all settings at the
sign. Only a few of them are normally displayed on the
main window.

Press OK when finished reviewing the data.
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Actions - Advanced Features

This dialog shows a list of all advanced features available for the particular
sign.

Shown at the right, the “Clear File System” feature will delete all files at the
sign .

 

 

 

 

 

 

 

TOOLS MENU

The Tools menu gives you access to a few basic functions.

Sign Manager  allows a user to activate, archive, or delete the
sign definition files stored on the PC.

Convert Sign Description File  tool will convert sign description
files from previous versions of VisionSuite into a form that can be
used with this version.

Scan for Sign  tool allows one to scan through a list of serial ports
for a specified type of sign.

TS Tool  (Tech Support Tool) is an undocumented feature.

Admin Password  is where the Administrator Password can be entered.

Options  is where various features for Vision Setup and other applications are maintained.
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Sign Manager

When more than one sign exists, there may be a need to
archive or delete a previously generated sign definition file.
The features of this tool are the following:

• List of Signs  – The list of signs with the given setting
(i.e. active or archived).

• Active/Archive  (pull-down list) – Controls the list of
signs display.

• Delete  – This will permanently delete a selected sign.

• Active  (button) – Allows you set a selected sign to
active.

• Archive  (button) – Allows you set a selected sign to
archive.

• General Information  – The General information
about the sign.

Convert Sign Description Files

When moving from a previous version of VisionSuite to the
newest version, some additional parameters have been
added to the sign description (or sign definition) files.

This tool can select the previous sign description file and
convert it to a newer version.
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Scan for Sign

In some situations, during the installing of a new sign, it may be unclear as to which
serial port on the PC that the sign is connected. This utility allows the user to scan
multiple serial ports for the sign.

The features of this tool are as follows:

• Type  – Specify the type of sign to scan for.

• Speed  – Specify the speed of communications that the serial port should be
set at for the test.

• COM Ports  – Specify the start and stop port to scan.

• Address  – Specify the range of addresses that the sign may be set to.

• Results  – Displays all of the results of the scanning process.

• Search  – Starts the scanning process.

• Stop  – Stops the scanning process.

Options

The Options for Vision Setup have been greatly enhanced
from the previous versions. The list on the left indicate all of
the sections of control that are available. Some of these
sections only apply to Vision Setup; some, to other
applications within VisionSuite.

The sections are as follows:

• General  – Basic control of certain operational
features of the interface.

• Software Passwords  – Allows for the settings of an
Administrative Password for VisionSuite.

• Connection  – Settings for overall-general operation
of VisionSuite communication applications.

• Logging  – Allows you setup logging.

• Reports  – Allows you select certain report options.

• Prompts  – Allows you to enable/disable certain common user prompts.
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Options - General

The General section allows the user to set the following
items:

• Automatic Load  – The last selected sign is
automatically loaded the next time the application
is used. The Sign Selection dialog is not shown.

• Show Sign Selection  – The Sign Selection
dialog will automatically appear when the
application is launched.

• Show Sign Selection when one  – Normally
when there is only one sign description file, the
Sign Selection dialog will automatically select the
sign and not show the dialog.

• Show Sign Name  – Display the sign name in the title bar of the application.

• Show Online  – Display the ONLINE state of the sign in the title bar of the application .

Options – Software Passwords

The Software Passwords section allows a user to set an
Administration Password. Once set, only the
Administration Password must be entered in order to gain
access to certain feature of the application.

It is very important to keep a record of the password. If
the password is forgotten, then a special process must be
undertaken to remove the password.

 

 

 

Options – Connection

The Connection section allows the user to set the
following items:

• Automatic Disconnect  – If the connection to the
sign exceeds the maximum number of
“reattempts”, then the software will automatically
disconnect from the sign. It is useful to have this
selected when initially installing a new sign. It will
give a visual cue to whether or not the sign is
responding properly.

• Automatic Reconnect  – If the sign is initially
connected and then the connection drops for
some reason, the application will automatically
reconnect to the sign after “Reconnect Interval”
seconds.
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• Online Test  – There are three online tests; Basic, Intermediate, and Advanced. It is recommended to
leave it set to Intermediate.

• Online Test Interval  – Specifies how often the sign is tested for online state.

• Error Pause  – The number of seconds that a communication error message will appear in the
Communication Status region. Note, that this is a maximum time and not a minimum time. If another
message comes along, then the error message will disappear. The Logging Feature can be used to
examine recent errors.

• Do not retrieve …  - This setting is useful when trying to connect to a sign with a large number of
messages. As the number of messages at the sign increase so does the time it takes to read the file
information .

Options – Logging

The Logging section allows the user to set the following
items:

• Enable Logging  – This button enables or
disables logging for all signs.

• Use one  – Normally, one logging file is more
than necessary.

• Allow for separate  – When many signs exist,
then it may be useful to separate the log file for
each sign. When this is set, the Log File setting
should be altered within each sign description.

• Level  – Specifies what type of events are going
to be recorded.

• Maintenance  – Specifies how the events are added to the log file.

• Days/Number  – Specifies the number of days or events to retain in the log file.

• Delete Log  – Automatically deletes all log files.

The log files are all stored in the LOGS subfolder of the main VisionSuite installation folder.

Options – Reports

The Reports section allows the user to set the following
items;

• Use Form 1  – This specifies that the “Form 1”
will be used when generating a report for Test
Communications.

• Archive Test Results  – When selected, all test
reports that are generated will be stored into an
archive folder.

• View Archive  – Shows a list of all of the archived
test results. One can use the list to view the
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reports.

• Clear Archive  – Clear all of the archive files from the archive folder.

The Test Communication archive files are all stored in the CommTests subfolder of the main VisionSuite
installation folder.

Options – Prompts

The Prompts section allows the user to enable and disable
certain prompts within the applications.

When you want to change a prompts state, double-click the
item in the list and the Prompt Control dialog will appear.

 

 

 

 

 

The Prompt Control dialog gives a description of the prompt
and allows for the enable/disable of the state.

 

 

 

 

 

 

 

FAST KEYS

Below is a list of all of the acceleration keys for access to various features.

  CTRL+N New Sign

  CTRL+O Select a new sign

  CTRL+P Print Summary

  

  CTRL+SHIFT+C Connect to the sign

  CTRL+SHIFT+D Disconnect from the sign
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  CTRL+SHIFT+T Run the Test Communications

  F5 Refresh ONLINE Status information

  F9 Show Files or Scan for File Information

  CTRL+SHIFT+U Update All Parameters

  CTRL+SHIFT+V View All Live Settings

  CTRL+A Show the Advanced Features dialog

TROUBLESHOOTING

I cannot seem to see my modem in the modem list dur ing setup.

This indicates that your version of Windows does not see the modem properly. You may have to update the
driver for the modem or reinstall the modem entirely. Depending upon the version of the Windows that you’re
using, a simple reboot of the computer may resolve the problem. If the problem persists, contact the
manufacturer or reseller of the modem for assistance.

How do I setup my older sign?

If your sign is pre-1997, it may be based on a H20 controller. In this case, you can only connect to the sign via
a modem. Direct connection via the parallel port is not available.

My sign is always OFFLINE. Where is the problem?

When a sign is OFFLINE, the problem may be in one of three areas.

1. Problem with the PC or the configuration of the sign within Vision Setup.
2. Problem with the link between the PC and the sign.
3. Problem within the sign itself.

Listing all of the possible PC problems is beyond this “Troubleshooting” section. In general, if your PC has
been working properly and you have not been experiencing any “flakiness” with you PC, then we can generally
rule out PC problems as a cause.

The most common Vision Setup mistake which can lead to an OFFLINE status for the sign is setting the Serial
Port to the wrong port. Many PCs have two serial ports. In this case, try changing the Serial Port setting to
another port.

Link problems can be very complex. However, there are some very common issues that can be examined.

• If your link is via a modem to a “cell-modem connected” sign, the problem may be a very poor cell site
connection. This may have something to due with problems within the local cell site or problems within
the cell-modem hardware located within the sign.

• If your link is a RS485 converter, then the problem may be in the converter. For certain converters,
there are 2 LED lights on them (for Receive and Transmit). If one or both of these lights are constantly
ON, then you may have a faulty converter.

• If your link is a wireless device, make sure you have a direct line-of-sight to the sign. Most wireless
system will not work through concrete wall or through tinted windows.

• The final common link issue is a broken or cut cable. The cable may be able to be spliced or replaced
depending upon the damage.
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Finally, a problem within the sign can occur. When a large electrical storm passes, a sign may get damaged
due to lightning strikes. Even when lightning strikes occur a distance away, the shear power of the lightning
can cause serious problems to many electrical devices. The LED sign is no exception. No level of electrical
protection can protect a sign from a direct lightning strike. Although this type of scenario is rare, it has
occurred. The more common sign problem is simple hardware failure due to vibration damage during shipment
or installation. This may be as simple as a dislodged connector or a more serious broken board.

In order to determine what the exact problem may be, it is recommended that you do the following;

• Note down when the problem started. Try to recall any “new” events (such as storms or nearby
electrical work) in the area.

• Note down the general details about the sign. For instance, when it was purchased, where it’s located,
and how the sign is connected to the PC.

• Finally, contact your Service Technician provider. Talking through some of these details with a
qualified Service Technician will quickly resolve your communication problems.

My sign is showing that it is ONLINE. However, I’m getting an error when I connect and none of the con trols
are available. What’s happening?

With H20/H21 based signs, the most common situation is that the sign has been powered off for more than a
week. The operating system at the sign has been lost and must be resent to the sign.

When you connect to the sign, the only button that should be available is the “Update” button next to the OS.
Press the Update button and allow the OS to be resent to the sign.

I have forgotten the Hardware Password that I’ve se t. What can I do?

It is VERY important to always record the hardware password that you set. The password is not known to the
sign distributor, installer, or the manufacturer.

The password is stored within the electronics of the sign and cannot be reset from your PC without knowing
what it is. Therefore, you will require a qualified Service Technician to service the sign and to manually reset
the electronics to clear the password. Please contact the company you bought the sign from for further
assistance.

Where do I enter my “Authorization Code”?

When connected to your ONLINE sign, from the Actions menu item, select the“Password & Code” and
then“Authorization Code”. Enter the password that has been provided, press the TAB key, and enter the
password again. PressTAB again and then select OK. The “Time Limit” (or Time Expired)setting will be
cleared and you’ll be able to use you sign again.

The Time Left entry is showing “Require Authorization  Password” even though I know I have several days le ft
before I need to enter in the Authorization Code.

The sign has not expired. You have set a “Hardware Password” and you have not yet entered it. Go to the
“Hardware Password” dialog and enter your password. Once completed, the time limit will display as expected.
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OVERVIEW

Vision Edit is the full-featured message editor. It allows you to
create virtually any type of LED message, from basic text and
line drawing messages, to full blown multimedia messages
that include up to date movie technologies and web page
content. It allows you to create messages that contain any
number of keyframes of content, and to arrange this content
in a manner that ensures your message is intelligently
organized for eventual scheduling on the sign. Once your
masterpiece has been saved, you may preview the message,
or send the message to Vision Schedule for scheduling and
exporting to your actual sign hardware.

 

 

 

HOW VISION EDIT WORKS

This contains a basic list of key features and a brief explanation of them.

• Vision Edit can create messages of mixed content. Messages consist of one or more keyframes, which consist
of these types of data:

• Bitmap (image) data, which may be imported from sources like movie clips or HTML web pages.

• Time / temperature / news data for live information display on the remote sign.

• Links to external media such as movie clips or web pages.

These three basic keyframe types allow you to create messages from all sorts of existing media, or start fresh
with your own custom message data.

• Industry standard bitmap editing tools allow for easy image maintenance in Vision Edit. If you can use the
Microsoft Paint™ program, you can use Vision Edit!

• Vision Edit is capable of importing existing HDD message files from older HDD software. These files types
include the 16-bit HDDVision Editor VED files, and the H1020 based MSG files. These files are imported and
automatically converted to Vision Edit VED files and allow you to maintain those messages in their new format,
hence, your investment in time for older messages is preserved.

• Vision Edit allows for easy insertion, reordering, removal or copy/paste of message content from one message
to another. Built in thumbnail mode allows for easy browsing of keyframes in a given message. Intuitive editing
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windows allow for multiple message files to be edited simultaneously, giving you the freedom to merge content
from many different message files into exciting new messages without recreating them from scratch.

• Vision Edit uses an innovative AVI based preview capability. No longer do you have to distribute specialty
software in order to preview your messages prior to approval for use at a remote sign. AVI files are industry
standard, hence, upon preview, you may choose to save the AVI file for later use, allowing for easy distribution
of preview files in an industry standard format.

• Vision Edit uses the custom “One Touch Scheduling” system, which allows a message to be inserted into a
fresh schedule in Vision Schedule with the touch of one toolbar button.

To get a quick understanding of the basic features of Vision Edit, please review the Examples below or go through the
Tutorial.

Vision Edit has “pixel-by-pixel” control and is designed for graphics, animations, and basic text control. In comparison,
Vision Quick Text is for the entering of text files and the control of each row. Depending upon your requirements,
Vision Quick Text may be a better choice for you.

OPENING VISION EDIT

When more than one sign is configured for your computer,
Vision Edit starts up with an empty workspace, as shown
below. Upon startup, you may click the NEW toolbar icon to
create a fresh message, or click the OPEN toolbar icon to
load an existing message. All other application options are
disabled until an editing session begins.

 

 

 

 

 

Vision Edit can create a blank, fresh message. Since a
message must have some basic properties associated with
the stored content, the first task is to specify the sign type you
are designing for. Note that the specific sign you select isn’t
recorded in the Vision Edit .VED output file. Instead, three
important sign characteristics are obtained.

• Sign width in pixels.

• Sign height in pixels.

• Sign color palette characteristics.

These three pieces are obtained by clicking the NEW
message toolbar icon, or selecting File | New from the main
menu. The standard VisionSuite Sign Selector will appear.
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Choose an existing sign that matches the characteristics you wish to design for.

When only one sign is configured, Vision Edit automatically
starts a new editing session for you with the sign’s settings.

When the editing session begins, the status bar to display the
current sign width & height and a blank keyframe list will
appear.

Vision Edit will also display the X-Y position of the mouse and
the extents of objects such as circles, rectangles and other
objects that have a width and height associated with them,
which is helpful in placing graphical content at an exact spot
in your bitmap.

 

 

 

CREATING A MESSAGE

Vision Edit is designed to allow you to add multiple keyframes
(or frames) to one message (or file). The “Keyframe List for
this Message” section (shown to the right) will display a list of
all of the keyframes that you add to this message.

You can add keyframes by pressing the INSERT key on your
keyboard, or by clicking either the APPEND or INSERT
images on the toolbar as shown in the main user interface
image above.
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When you append or insert a new frame, the New Keyframe
Selection dialog will appear as shown.

A keyframe can be selected from one of the following
choices:

A Bitmap Keyframe  allows you to create virtually any
graphical content, including arbitrary text that lies on top of an
image.

A Time/Temp/News Keyframe  allows you to create a
message that includes live information, such as the current
time and date, the current temperature that the remote sign is
measuring, or in the case of a higher end video board, live
access to news or financial sources.

An Animation Keyframe  allows you to manage the
animation of a series of bitmaps that may be merged together
to create a simple movie. Animations are useful for
monochrome signs, which are not well suited to the display of MPG or AVI movie clips.

The Import Keyframe  options above allow you to create a new bitmap keyframe, with the information in the keyframe
already preset by the data you are importing.

The Link To External Keyframe  options above are useful if you wish to insert into a message all of the frames
available in a movie clip (AVI or MPG) or if you wish to link to a web page that may contain content such as Flash or
Shockwave. By adjusting the duration of the linked web page, you are able to eventually export the captured content
into your outgoing messages to the LED signage. This will be discussed further below.

The comment  section allows you to enter a unique description for each keyframe. This is optional.

Once you have inserted or appended a keyframe, you will
notice that the list of keyframes will automatically expand. It
will show either a thumbnail bitmap for your image based
keyframes, or an icon showing the nature of the other types
of keyframes, so that you can get a feel for your message
content at a glance. You can open the corresponding
keyframe editing window by double clicking on any keyframe
in the list.

You may append or insert messages based on the currently
selected keyframe in the keyframe list. Insert will put new
keyframes in front of the currently selected element, whereas
append will place the new keyframe after the currently
selected element.

At any time, you may shuffle keyframe elements around the
list using the UP and DOWN arrow buttons in the keyframe
view.

You can delete a keyframe from the list by clicking the DELETE button on the toolbar, or by hitting the DEL key on
your keyboard. The deletion cannot be undone, so take care you do not select this option by mistake.

You can also use the Edit menu to Cut, Copy or Paste keyframes into the keyframe list. This allows easy manipulation
of the keyframe list using Windows standard clipboard operations. You may also cut or copy frames between
messages, which allows you to build new messages based on previously created content quickly and efficiently.
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You can toggle the icon or thumbnail view by clicking on View menu and selecting the Thumbnails In Keyframe List
option. A checkmark will indicate whether thumbnails are currently active or not.

When you are satisfied with a message, you may click the SAVE toolbar button, which will pop open the Save-As file
selector where you may choose to overwrite an existing file, or to create a new file. You will be prompted if the name
you have chosen already exists in your output folder.

Note that Vision Edit has no restrictions on where you wish to save your content. You are advised to choose an easy
to remember location on your hard disk to save your work, for example, C:\HDD\MESSAGES.

Once you’ve saved your work, you will need to re-save your work whenever you make a change to your message.
Changes include the order of keyframes in the list, adding or removing keyframes, making changes to the bitmapped
contents of a keyframe, or adjusting the time duration and/or effects of any keyframe. The software will prompt you to
save if you attempt to exit with unsaved data, and you may choose to ignore the warnings to exit a message without
saving. This is useful if you have “messed up” a message and wish to reload a fresh copy of the original message.

BITMAP KEYFRAMES

Bitmap keyframes give you pixel-by-pixel control of the image
that will appear on the sign.

Vision Edit contains a fully featured bitmap editor that allows
for virtually any kind of basic image manipulation, including
the ability to paste bitmap data in the clipboard directly into
your message. When you open a bitmap keyframe, you will
see a window as shown on the right.

As you can see, the current effect selection and total time
duration values are visible in the top left corner of the editing
window. You are able to adjust the zoom level of the bitmap
area so that you can zero in on detailed image information if
you like. As your cursor moves about the bitmap editing
surface, you will notice that the position indicator will show
you the current co-ordinates. Position [1, 1] is in the upper left
corner of the window, and the position identified by the
bitmap width, height will be shown when you are in the lower rightcorner.

Bitmap keyframes enable the bitmap tools that are normally docked to the left on the bitmap
window.

These controls are identical to the controls within Microsoft Paint™.

The following table shows a mapping of the icons shown in the Draw Tools control to the right.

Depending upon the capabilities of your sign and the pixel resolution of your sign, the selection
and “smoothness” of the various controls will change.

As one can imagine, a sign that is 640x480 pixels in size can produce a much smoother-looking
circle than a sign that is only 100x32 pixels in sign.

Foreground and Background
Color Selector

Line Thickness
Selector

Clipping Tool Eye-Dropper Tool Eraser Tool
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Fill Tool Freehand Tool Brush Tool

Line Tool Airbrush Tool Text Tool

Outlined
Rectangle Tool

Outlined Rounded
Rectangle Tool

Outlined Ellipse
Tool

Outlined/Filled
Rectangle Tool

Outlined/Filled
Rounded Rectangle

Tool

Outlined/Filled
Ellipse Tool

Filled Rectangle
Tool

Filled Rounded
Rectangle Tool

Filled Ellipse
Tool

 

When you select the color control, the appropriate color selection dialog will appear.

When the sign is monochromatic (one color), the color
selection is very basic. The color selection dialog will show a
list of colors and the percentage of RED, GREEN, and BLUE
used for the color.

Shown to the right is the two color selection for a Red
Monochrome sign.

For a 16 Color LED sign, the number of colors that can
chosen from increases. Correspondingly, the list grows.

 

 

 

The color selections do not necessarily represent the exact
colors that the sign will display. The exact colors displayed
may be slightly different due to the color wavelength of the
LEDs used within the sign.

Nevertheless, the selection is “representative” of the colors
that the sign will show.
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The new 256-Shade signs have the capability of displaying
256 unique shades.

You select the desired color by moving the mouse cursor to
the location on the horizontal color-bar and clicking the
mouse. You can also enter a value manually within the Value
control.

The control shown to the right is for an Amber sign with 256
shades.

When your sign is a full color sign, the color selection is vast.
The color selection dialog, shown to the right, is the standard
Windows color selector. By default, there are 48 predefined
colors, 16 custom colors, and 16+ million other colors from
which to select.

The selection capability within this Windows dialog is based
on the color capability of your PC’s graphics card and
monitor. If your computer can only display 256 colors, this
color selection will not be as extensive. Nevertheless, it may
be adequate for your sign.

It is recommended that your PC has full color capabilities in
order to have full color selection.

 

When entering text with the Text Control (i.e. the “A”), the
following window is displayed. Within this dialog you can:

• Enter text within the control on the left.

• Control the position of the text within your selected
region with the 9-buttons at the bottom-right.

• Select a Windows or Raster font. {Note: Raster fonts
are useful for small matrix signs.}

• With multi-color signs, you can select “Advanced” to
apply an effect to the font.
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The Advanced button opens the “Font Effect Options” dialog.

The following items can be adjusted:

• Ignore Options – This enables/disables the font effects.

• Color – By clicking the rectangular region, you will gain
access to the color control. This will allow you to set the
effect color.

• Shadowed Text – Enables the shadowing text effect. The
four buttons below this selection control the direction of the
effect.

• Outlined Text – Enables the outlined text effect.

• Blurred Text – Enables the blurred text effect.

• Depth – Controls how many pixels “deep” the effect is
generated.

 

 

As with other existing VisionSuite applications, a keyframe
will have an ON effect, a HOLD effect, and an OFF effect.
Effects are selected using the appropriately named E button.

The COMMENTS button in the bitmap window allows you to
insert a commentary string for the current keyframe. This has
no playback connotation – it simply is used to help describe
individual keyframes from the main keyframe list perspective.
By using a simple descriptive string, the main keyframe list
can be read easily to help you get a feel for the overall
message content at a glance.

The Zoom Level controls the size of the drawing region.
Scrollbars will appear if the region becomes larger than the
bitmap window.

The Effects Selection dialog allows you to control the ON,
HOLD, and OFF effects for this frame.

There are more than 50 effects to choose from. By default,
the selection is “CHANGE”, “HOLD”, and “NONE” for the ON,
HOLD, and OFF effects respectively.

Depending upon the sign, the duration of the certain effects
can be altered. For the H20/H21 controller based signs, both
the ON and OFF effects have fixed durations. However, in all
cases, the HOLD effect’s duration can be changed.
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When you double-click the mouse over the duration for the
HOLD effect, the “Enter Duration” dialog will appear. You can
control the effects time by seconds and milliseconds. The
fineness of this control is dependent upon the sign’s controller
and the select effect.

 

 

From the main bitmap editing window, you will see the MODE
REGION button. This is useful if you wish to restrict the effect to a smaller
area than the entire keyframe width and height. By default, a given
keyframe will have its effect operate over the entire bitmap region. With
MODE REGION, you can adjust the area to a smaller rectangle, as well
indicate if the image will be blended with a background keyframe (for the
ON effect) or with a foreground keyframe (for the OFF effect). Using the
above concepts, very sophisticated visual effects can be generated.

Because at design time you may be referencing a keyframe for a
foreground or background effect that does not yet exist, no error checking is
performed at design time. However, once you schedule and export the
message with this keyframe data, the rendering software will do an integrity
check to ensure that the keyframe specified for foreground or background
does indeed exist, and return with an error message to ensure there is no
invalid information being generated.

When you’re in a bitmap keyframe, the items within the Image menu
become enabled. For more information on these features, please refer to the Image menu section below.

TIME/TEMP/NEWS KEYFRAMES

When the “New Time/Temp/News Keyframe” is selected from
the New Keyframe Selection, a window similar to the one
shown to the right is displayed.

Although similar to Bitmap Keyframes in several ways,
Time/Temp/News Keyframe editing window allows you to
insert a predefined “object” that instructs the operating
system within the sign (or sign computer) to automatically
insert a Time, Temperature, or News item. These items are
automatically generated.

The familiar effect selection and overall time displays are
visible in the top left corner of the TTN editing window. As was the case with the bitmap editor you can click on the
effect selector to choose the ON, HOLD, and OFF effects for this TTN keyframe. You can click on the time duration to
adjust the hold time, as was the case with the Bitmap Keyframe.

As with Bitmap Keyframes, TTN data can be superimposed on top of a
background frame. This can be adjusted by clicking the BK FRAME display.
Again, a dialog will appear that will ask you for the keyframe number that
you wish to use. As documented above, no error checking is performed at
design time. The export from Vision Schedule will indicate if the background
number is invalid, and export will be aborted before an error can occur.
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The most notable difference with the TTN editor is that you have a drop-list selection of a number of live data
elements. These include the follow;

• 12 hour time

• 24 hour time

• Celsius temperature

• Fahrenheit temperature

• Date

• Day of the week

Note that 24-bit HDDVision (i.e. VISCONT controlled) signage will not support “e” or “f” from the above list .

When you wish to insert a given element, click the ADD button. A Details dialog will appear as shown.

When you add an element, you can make a selection from
one of the six TTN data types. You can adjust the font and
color of the object with this dialog box. The percentage red,
green and blue will be shown after selecting the color. You will
see that the TTN object selection you make will adjust the
simulated text. Each object has a simulation that is used for
justification purposes.

As you can see, you can also “quick adjust” the justification of
the object, based on its pre-programmed simulated text. Note
that this is a close approximation of how the justification will
appear, and the target sign controller may make slight
adjustments to the display if the data shown doesn’t quite
match the simulated text. For example, if the temperature is “-
22C”, and you right justify the text, you may find that the sign
controller may lop the “C” off of the display, because there is
one additional character in the display compared to the
simulated text. It is impossible to predict the actual values
displayed at design time, hence, use this feature with this
information in mind. When you choose “custom” justification,
you will be able to place the object anywhere you wish using
the mouse, when you exit this dialog box.

The selection of a font is limited by the type of sign. For
instance, most standard message centers are limited to Raster Fonts for Time/Temp/News keyframes. If you use a
Windows font (or True-Type Font), it will be automatically substituted with a 4x5 Raster Font .
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When selecting a Raster Font, you will see the following
dialog. For multi-shaded signs, you will be able to select an
adequate shade color and the effect for any Time and
Temperature setting.

 

 

 

 

 

 

 

The Advanced button takes you to a screen that adjusts a
number of low level features for TTN display, such as the
character spacing, leading plus symbol, or leading zero flags.

 

 

 

 

 

 

 

When editing a Time/Temp/News Keyframe, the window is
almost identical except that the “Add New Object” will change
to an Edit button when the object is selected.

Therefore, to edit a currently existing TTN element, just select
the object with the mouse and then press the Edit button. The
dialogs shown above will display without control over the
object “type”. If you wish to change an element from a time to
date object, remove the element and then add a new object.

You are allowed up to 100 TTN elements in a single
keyframe (some older signs are limited to only 10 elements).
This should be more than ample for even the most ambitious live information display. It is recommended that you use
this feature sparingly, as having too much content is detrimental to getting your message out to your intended
audience.

WARNING

At the time of writing, export to 24 bit HDDVision compatible signage will not contain Time/Temp/News
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keyframes. Therefore, any TTN elements created using this tool for eventual export to a 24 bit HDDVision sign
will not be available in the exported VPY content for that type of sign.

Workaround

Vision Schedule contains a built in “hook” that allows for the insertion of predefined VPY export files into a
schedule. These predefined VPY files are built using the original 16-bit VisEdit program (distributed with your
24-bit HDDVision signage). There are hooks to support the display of Time and Temperature in both
Fahrenheit and Celsius. You will be able to build the look and feel of these TTN messages using the older
software, and be able to schedule them into Vision Schedule as if they were messages exported from Vision
Edit. Consult the Vision Schedule notes for further details on this workaround.

ANIMATION KEYFRAMES

When the “New Animation Keyframe” is selected from the
New Keyframe Selection, a window similar to the one shown
to the right is displayed.

Vision Edit provides a very basic editor for creating
animations. The animation feature has been included in order
to support backward compatibility with older systems.

Users of the H1020 software will be familiar with this concept.
An animation keyframe consists of one or more non-playable
keyframes, which will be merged up to ten layers deep. Each
layer can have its own unique keyframe, at its own unique X
and Y position, so that the merged series of keyframes create the illusion of movement from keyframe to keyframe.

As this facility has been provided solely for backward compatibility with existing users, other customers should be
using more modern animation concepts, such as AVI or MPG linked files to provide animated content for their signage.
Although it is possible to build animations using this facility, it is based on an animation concept that is very outdated
by today’s standards, and hence, should be avoided unless you must maintain backward compatible animation data.

For more information on how to use this feature, please refer to the animation example.

IMPORT KEYFRAME OPTIONS

There are several Import Option selections which allow you to
import a specific frame within an animation file (AVI or
MPEG), a non-animation bitmap file (BMP, JPEG, GIF, etc.),
or a portion of an HTML page (from a file or URL).
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Vision Edit can import an HTML page either via filename on
the local hard drive or from a remote site via URL.

This importing process grabs a snapshot of the HTML page.
Once obtained, the image becomes equivalent to a Bitmap
Keyframe. The standard Bitmap Keyframe features and
settings then apply.

This feature is useful for large signs. Smaller signs may not
have the resolution to adequately display the images from
HTML sources .

 

 

 

 

 

 

When importing an MPEG or AVI animation keyframe, you
can step to the specific frame within the file and then “Import”
the single frame.

This importing process extracts only the selected frame.
Once obtained, the image becomes equivalent to a Bitmap
Keyframe. The standard Bitmap Keyframe features and
settings then apply.
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When importing a standard BITMAP file type, such as BMP,
JPEG, and GIF, you will first select the compatible file and
then see the Import Image dialog (as shown to the right). You
can either crop the image (top-left corner of the image) or
resize it to the size of the sign.

This importing process converts the file to a standard Bitmap
Keyframe. The standard Bitmap Keyframe features and
settings then apply.

 

 

 

LINK TO EXTERNAL KEYFRAME OPTIONS

You can also link to an HTML page, AVI files, and MPG files.
These are ideal for linking to animation files created in other
applications.

 

 

 

 

 

 

 

Since Vision Edit can link to an HTML file either via filename
on the local hard drive, or to a remote site via URL, the HTML
Link Editor allows for basic adjustment of how this linkage will
occur. When you open this editor, you will be presented with
a simple window that shows the duration of the keyframe, the
HTML page itself, along with the familiar COMMENTS button.
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To adjust the time duration, simply click on the time value and
you can enter a new number of seconds and milliseconds for
fractional duration. There is a small button with the familiar
“refresh” icon. Click the REFRESH button to ensure that the
HTML information displayed is correctly updated in the event
that the HTML file didn’t load as expected, or is changing
externally to Vision Edit. If a bottom scrollbar appears, you
can tell Vision Edit to force the removal of this bottom
scrollbar, which sometimes improves the appearance of the
web page within the width, height dimensions of your LED sign.

Note that the web page in question (entered within the HTML Import dialog) will be converted to an animation of
frames for the sign type you are scheduling for. Hence, Vision Schedule will render this linked file into a sequence of
frames that will be stored in the exported version of your message, and the exported message will then play back
correctly on the remote sign. Hence, do not worry if your remote sign has no Internet access. The linked keyframe is
not accessed live on the sign, only the “captured” data will be played on the sign.

Note that you cannot adjust the zoom level of a web page. Only MPG and AVI linkages will allow for the zoomed
appearance of their content.

This feature is useful for large signs. Smaller signs may not have the resolution to adequately display the images from
HTML sources.

In a similar fashion, Vision Edit can link to external movie clip,
either in AVI or MPG format. A similar editing window will
appear to show you the raw movie footage you have
selected. Again, do not be concerned that the remote sign
cannot normally access this type of data. Vision Schedule will
ensure that the exported data contains a converted copy of
the movie clip, in the native format of the sign you are
exporting to. Thus, as a pair of examples, an MPG file will be
converted into a MSG file if exporting for the standard
message center system and an AVI file will be converted to a
VPY file if exporting for the 24-bit (or better) video system.

As before, you may adjust the comments and time duration of
the movie clip.
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FILE MENU

The File menu gives you access to the basic functions that control &
maintain the file that you are working on.

New allows you to create a new Vision Edit file.

Open  allows you to open an already existing Vision Edit file.

Import  allows you to open an already existing Vision Quick Text file
or a rendered file (MSG files for standard message centers).

Open for Rescale  allows you to open an already existing Vision Edit
file and readjust its resolution.

Close  allows you to close the current Vision Edit file without exiting
the application.

Save allows you to save the file you’re currently working on.

Save As  allows you to save the file you’re currently working on as a
different name.

Print  allows you to print a basic report on the various keyframes
within the file.

Preview  allows you to preview the file that you’re currently working on.

One Touch Scheduling  will automatically launch Vision Schedule and place the current Vision Edit file into the
schedule list.

Most Recently Used  file list allows you to select one of the previous four files that you have been working on.

Exit  closes Vision Edit.

Open/Save/Save As

Whether you use Open, Save or Save As, the common File
Dialog will appear (shown to the right). The title and the
button will be named appropriately.

Note that all Vision Edit files have the file extension of VED.
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Open for Rescale

This is handy when you need to take an existing message for a
lower resolution sign, and reuse it on a higher resolution sign.

The operation is simple: when you choose this option, the file
selector will appear, asking you to for the VED file to load. Upon
selection, the sign selector dialog will appear, similar to how you
would choose a sign type for a new message. Upon selection of the
sign type, a new dialog will appear as shown.

This dialog allows you to adjust the original file’s bitmap data into
the new resolution for the sign type chosen. The default is to place
the original data in the top left corner (crop). This means that if the
new sign is larger, the original message bitmap data will be placed
into the top left corner of the new message’s bitmaps. The
remaining “crop” options simply select the location of where the
original data will be placed.

If the new resolution is smaller than the previous message resolution, then the “crop” operations will take only the
correct number of pixels from the original message’s bitmaps. For example it would take the top left corner of the
original message bitmaps to the maximum resolution of the new sign type.

The final option will allow you to rescale (stretch or shrink) the original message bitmap data into the new matrix. This
may generate either “pixelated” or “blocky” images when stretching, or pixels may be missing when shrinking.
However, the original message data will be fully stretched or shrunk into the new resolution, thus keeping the entire
message intact.

Upon completion of this dialog, the new message will appear, with a blank filename. You must perform a SaveAs
operation to save this cropped/rescaled message as a file.

Preview

When selecting Preview for the first time, you will see the Video
Compression dialog. Although several “compressor” types may exist
on your computer, it is recommended that you use “Full Frames
(Uncompressed)”.

After selecting this the first time, the dialog will not be shown again.

 

 

 

When the Preview window opens, the message will
automatically start playing. You can move around the
message, pause it, and even save it (if needed). When you’re
finished previewing the message, simply press the Done
button to close the window.
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Exit

You can exit the application by one of two methods. First, you can select
“Exit” from the File menu. Second, you can press the “X” (close) button at
the top right of the application or current file. In either case, you will see one
of the dialogs shown to the right.

 

 

 

 

 

 

 

EDIT MENU

The Edit menu gives you access to functions that control the “how”
you edit objects within list of keyframes or within a keyframe itself.

Undo  allows you to undo a current change. This feature only applies
to certain changes. Most features are not undoable.

Cut, Copy, Paste, and Delete  selections are the standard functions
that exist within most editing applications.

Select All  will select all the objects within a keyframe.

 

VIEW MENU

The View menu gives you access to user interface features.

Toolbar  shows you a set of small icons at the top portion of the main
window. These icons are short cuts to various features within Vision
Edit.

Status Bar  shows you a variety of information at the bottom of the
main window. This can be especially useful during editing of bitmap
keyframes.

Drawing Tools  is the standard bitmap drawing tools shown to the left on the main window.

Thumbnails  are “images” of the keyframe items within the keyframe list.
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Toolbar

When the Toolbar is not “docked” (to the top of the main window), the Toolbar can
appear as shown to the right. In order from left to right (and top-down), the icons
represent the following features:

• New File

• Open File

• Save File

• Toggle Drawing Tools

• Cut

• Copy

• Paste

• Delete

• Undo

• Add Keyframe After

• Insert Keyframe

• Print

• One Touch Schedule

• Preview

• About Vision Edit.

IMAGE MENU

The Image menu gives you access to image alteration features.
These mainly deal with altering Bitmap Keyframe images.

Skew  allows you to skew a selected section of a bitmap.

Stretch  allows you to stretch a selected section of a bitmap.

Flip / Rotate  allows you to flip or rotate a selected section of a
bitmap.

Invert Colors  allows you to invert the color a selected section of a bitmap.

When within the Bitmap Keyframe, you can use CTRL+A to select the entire bitmap region or use the select tool within
the Drawing Tools to select a specific region.

Skew
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A horizontal skew is similar to making a letter “A” italic (i.e. A).
In this case, the selected image gets “tilted” in the horizontal
direction. Both horizontal and vertical skew are available for
bitmaps.

 

Stretch

This tool can be very useful if you want to shrink or expand a
particular object.

 

 

Flip / Rotate

The Horizontal and Vertical Flip features are just a specific
example of rotation. This is very useful if you want to create a
mirror image of an object.

When rotating a selected object by anything other than 90
degree increments, the object may get severely distorted.
Remember that the more resolution you have within your sign,
the better the rotation will appear.

 

 

KEYFRAME MENU

The Keyframe menu gives you access to features that mainly
control the Keyframe List.

Each item is self-explanatory.

The “Select Keyframe Effect” item can only be used within a
keyframe in order to have menu access to the effects.

 

FAST KEYS

Below is a list of all of the acceleration keys for access to various features.

  CTRL+N New

  CTRL+O Open

  CTRL+S Save

  CTRL+P Print
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  CTRL+Z Undo

  CTRL+X Cut

  CTRL+C Copy

  CTRL+V Paste

  DEL Delete selection or Delete keyframe

  CTRL+A Select All

  

  CTRL+K Skew

  CTRL+T Stretch

  CTRL+F Flip / Rotate

  CTRL+I Invert Colors

  

  INS Insert Keyframe Before Selection

  F2 Add Keyframe After Selection

  F3 Duplicate Keyframe

  F4 Select Keyframe Effect

TROUBLESHOOTING

No exported data from Vision Edit message.

This can be generated in a couple of ways. The Vision Edit file itself may have no keyframes of content.
Without content, there can be no exported data for the remote sign!

Another potential issue here is that the keyframe effect may be a combination of “NONE” for the ON effect, or
a HOLD duration of ZERO seconds. Since these values are a signal to the remote sign that nothing is to be
played for the keyframe in question, this may cause an export attempt to not create any exported content.
Simply adjust the ON effect and/or duration to nominal values and try your export again.

Note that the ON effect of NONE is used to indicate that a keyframe has no visual appearance. This is a
convenient way to indicate that a given keyframe will be used as either an animation frame (thus controlled via
the animation editor), or as a background or foreground frame to be used with another bitmap effect or a TTN
frame.

Creating a message that contains only TTN keyframes and exporting this message for a 24-bit HDDVision
sign will generate no exported data due to the restrictions documented earlier. Consult the Vision Schedule
documentation for details on how to work around this restriction.

A Vision Edit message does not stop for a long time , or does not play the duration indicated.

This may be caused by a duration that is very long. Since each keyframe has its own independent duration,
the combination of many keyframes in a single message could easily create a single message that may take
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minutes to play on the remote sign. This is in of itself not a problem. However, it may be an unexpected
consequence of a complex Vision Edit message.

Note that some effects, such as SPELL or ZIP may take longer than the nominal 2 second ON/OFF effect
duration, as their effect speed is dependent on how many “spell” or “zip” cells are located. Because of this, use
the time duration values shown only as an estimate. Future HDD hardware will have stricter timing control then
older hardware, and hence, have exact time duration values available for scheduling purposes.

Importing or Pasting bitmap data causes colors to “d isappear”.

Again, this is not a software error, but a desirable feature based on the sign characteristics chosen at the time
you created the Vision Edit file.

As an example, let us assume that you have created a monochrome message 96 pixels wide by 64 pixels tall.
If you paste a full color image of a human face from Corel Draw into a bitmap keyframe, you cannot expect
that all the shades from Corel Draw will be transposed into a monochrome image! Instead, the software will try
to create an approximation of the original bitmap, using only red and black, as these are the only two colors
available on a monochrome sign.

Hence, you will only see red and black pixels after the paste or importation.

Again, this is not an error, but the only reasonable operation to perform, apart from simply disallowing any
image data that has color, which is almost impossible to pull in from external sources in today’s day and age of
multimedia data.

Preview doesn’t show the effects exactly.

The preview facility is designed to be “sign independent”. How a given effect plays on an H21 versus a 24-bit
Video board is dependent on the software that drives each of these hardware components. Thus, it is
impossible to create a perfect emulation of either of these two hardware platforms. Instead, a rendition of the
effect is generated in an AVI file, which gives you an approximation of how the effect will appear on any
external sign.

Again this is simply an approximation. Subtle differences will exist, however, the content will render correctly
on the remote sign based on the effect selected, as the real work of rendering the message to the LEDs is
done by the remote sign software.

Note that future signage built by HDD will better reflect the look and feel generated by the AVI preview, as the
preview rendering will also be used to construct the exported data used by future signage.
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OVERVIEW

Vision Quick Text is an application that gives row-by-row text
control. It’s WYSIWYG (What You See Is What You Get)
design gives you an immediate view of the frame that you’re
working on. It’s designed to compliment the bitmap-oriented
Vision Edit application. Although you can still enter text and
position it wherever you wish within Vision Edit, Vision Quick
Text provides an easy-to-use and structured row system that
allows you to type basic messages.

Vision Quick Text is designed as a basic text editing package
for both Message and Video signs.

 

 

 

 

HOW VISION QUICK TEXT WORKS

Once the main window has opened, you will have a user interface that will allow you to enter text with a “row-by-row”
control. The entering of text is done within the Text Rows region. The remaining controls on the left-side of the main
window will give you access to the basic features for the row that you’re working on.

The menu items give you access to various functions that can affect various aspects of each row, the frame, and even
the entire message file.

To get a quick understanding of the basic features of Vision Quick Text, please review the Examples below or go
through the Tutorial.

Vision Quick Text sole purpose is for the entering of text files and the control of each row. It is not intended for
animation files or graphics of any kind. In comparison, Vision Edit has “pixel-by-pixel” control and is designed for
graphics, animations, and basic text control. Depending upon your requirements, Vision Edit may be a better choice for
you.
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OPENING VISION QUICK TEXT

When more than one sign has been configured for your PC,
you will see this dialog each time you open a VisionSuite
application. If you only have one sign configured for your PC,
then it will automatically load as the sign to use. Therefore,
you will not see this dialog.

Once the sign has been selected, all of its capabilities are
automatically loaded into Vision Quick Text. The uniqueness
of the sign is taken into account and the application
customizes its interface for the sign.

When CANCEL is pressed, Vision Quick Text will open with a
“default sign” which may not be compatible with your current
sign.

 

 

 

THE MAIN WINDOW

The main Vision Quick Text window has several regions.

The view region  is the large black area to the right. It will
display the text that you type.

The control region on the left have several areas. The Text
Rows  region is where you type your text; the Font/Color
region is where you can alter your row’s font and colors; the
Spacing  region allows control spacing between letters and
lines; the Justification  region is where you can justify each
row; the Effects  region allows for control of the “travel mode”
and view of the current effects; the Frames  region is where
you navigate between each frame; and finally, the Sign
Summary  region is where you can view the type and size of
sign that you’re working on.

Text Rows Region

The Text Rows region has up to 6 rows enabled for larger
signs. The maximum number of enabled rows is dependent
upon the height of your sign. When there are 2 or more enabled rows, you can toggle
between the rows by either pressing the circle-button to the left of the text control, click
the mouse inside the text control, use the menu controls to toggle to the next (or
previous) row, or use a fast key.

When you select a particular row, the other controls within the control region will
automatically update with the row’s features.
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Font/Color Region

The Font/Color region allows you to see & change the current font and color settings.
The font button will either open the Raster Font selection or the TrueType Font
selection (Windows Fonts) depending upon the Edit menu selection.

The color button will open a selection control (shown below). From there, you can
control the text and background colors. These colors are shown in the color boxes to
the right of the color button.

Font Selection

When the Edit menu has “Raster Fonts” selected, the
dialog shown on the right will appear when the font button
is pressed.

The fonts that are displayed are part of the raster font
database within the FONT subfolder where VisionSuite
was installed.

 

 

 

 

When the Edit menu has “TrueType Fonts” selected, the
dialog shown on the right will appear when the font button
is pressed.

The fonts that are displayed are part of the TrueType
Fonts that are installed on your computer. The listing of
fonts is controlled by Windows. For more information on
the installation and removal of Windows fonts, please
refer to your Windows documentation.

Color Selection

 

 

 

 

When the color button is pressed, the Color Selection dialog will appear.
Press either button to select the color for text or the background color for
the current row.
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When the sign is monochromatic (one color), the color
selection is very basic. The color selection dialog will
show a list of colors and the percentage of RED, GREEN,
and BLUE used for the color.

Shown to the right is the two color selection for a Red
Monochrome sign.

 

 

 

 

For a 16 Color LED sign, the number of available colors
increases. Correspondingly, the list grows.

The color selections do not necessarily represent the
exact colors that the sign will display. The exact colors
displayed may be slightly different due to the color
wavelength of the LEDs used within the sign.

Nevertheless, the selection is “representative” of the
colors that the sign will show.

 

 

 

The new 256-Shade signs have the capability of
displaying 256 unique shades.

You select the desired color by moving the mouse cursor
to the location on the horizontal color-bar and clicking the
mouse. You can also enter a value manually within the
Value control.

The control shown to the right is for an Amber sign with
256 shades.
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When your sign is a full color sign, the color selection is
vast. The color selection dialog, shown to the right, is the
standard Windows color selection. By default, there are
48 predefined colors, 16 custom colors, and 16+ million
other colors to select from.

The selection capability within this Windows dialog is
based on the color capability of your PC’s graphics card
and monitor. If you have a computer that only has 256
colors, this display will not be as extensive. Nevertheless,
it may be adequate for your sign.

It is recommended that your PC has full color capabilities
in order to have full color selection.

Spacing Region

The Spacing region allows you to adjust the spacing of the
text within a row. Horizontal spacing controls the spacing between each character.
Increasing the value will the characters further apart. Vertical spacing controls the
space above and below the text with the row. This can be used to push the text up or
down within a row.

Justification Region

The Justification region allows you to position (or justify) the text within a row. The 9-
button control indicates the location where the text will be justified within the row. When
Custom Justification is used, you can control where text is placed within the sign based
on pixel location.

When “Travel Mode” is enabled for a particular row, 6 of the circle-buttons are disabled
and only vertical justification is available.

Effects Region

The final region is the Effects region.

Here you can view the “Effects” for the entire frame and control the “Travel Mode” for
the current row.

Travel mode is a row-by-row effect. The other effects are only for the entire frame.

Frame & Sign Summary Regions

The Frames region allows you to move between the various
frames within the message. Since Vision Quick Text allows
you to create multiple frame messages, you can toggle
between the frames with these buttons.

In order from left to right, the buttons are “Go to First Frame”, “Go to Previous Frame”, “Go to Next Frame”, “Go to Last
Frame”, “Insert a new ‘normal’ frame after the current frame”, and “Delete current frame”.

For additional, inserts and frame controls, refer to the Edit menu features.

The Sign Summary information is simply a visual reminder about the sign for which you’re designing a message.
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FILE MENU

The File menu gives you access to the basic functions that control & maintain the
file you are working on.

New creates a new Vision Quick Text file.

Open  opens an existing Vision Quick Text file.

Save saves the file you’re currently working on.

Save As  saves the file you’re currently working on as a different name.

One Touch Scheduling  will automatically launch Vision Schedule and place the
Vision Quick Text file (also referred to as the message file or simply the
message) into the schedule list.

Preview  allows you to preview the file that you’re currently working on.

Most Recently Used  file list allows you to select one of the previous four files that you have been working on.

Exit  closes Vision Quick Text.

Open/Save/Save As

Whether you use Open, Save or Save As, the common File
Dialog will appear (shown to the right). The title and the
button will be named appropriately.

Note that all Vision Quick Text files have the file extension of
VMG.

 

 

 

 

Preview

When selecting Preview for the first time, you will see the Video
Compression dialog. Although several “compressor” types may exist
on your computer, it is recommended that you use “Full Frames
(Uncompressed)”.

After selecting this the first time, the dialog will not be shown again.

 

 

 



User Manual VisionSuite Vision Quick Text

Version 3.1 69

When the Preview window opens, the message will
automatically start playing. You can move around the
message, pause it, and even save it (if needed). When you’re
finished previewing the message, simply press the Done
button to close the window.

 

Exit

You can exit the application by one of two methods. First, you
can select “Exit” from the File menu. Second, you can press the
“X” (close) button at the top right of the application. In the
second case, a similar dialog as shown to the right appears to
ensure that you want to close. By purposely selecting the “Exit”
from the File menu, you can bypass this dialog.

 

 

EDIT MENU

The Edit menu gives you access to functions that control the “how” you edit
text within the control regions.

Font Types  allows you to switch between Raster Fonts (useful for low-
resolution signs) and True Type Fonts (useful for high-resolution signs).

Rows  allows you to select the number of rows to be shown & editable within
a frame. The maximum row selection is limited by the matrix size of your
sign.

Clear All Rows  will clear all of the rows within the current frame.

Go To  items allow you to move between frames.

Insert Frame  allows you to insert a new frame before or after the current
frame. The type of frame can also be selected.

Delete Frame  deletes the current frame.

Move Frame  allows you to move the current frame to a different location in
the sequence of frames for this message.

Next & Previous Row  items allow you to move between rows within the current frame.

Text  gives you access to the “Custom Justification” feature.

Invert Color  inverts the text and background colors for the currently select row.

Effect  gives you access to the Effect Selection dialog. This allows you to set the effects for the frame.

Travel  gives you access to the Travel Settings dialog. This allows you to set the travel speed and direction for this
frame.
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Inserting a Frame

When inserting a new frame, you can add a Normal frame
(for normal text entry) or a Time/Temp frame. A Time/Temp
frame can be one of the following; 12 Hour Time, 24 Hour
Time, Temperature in Celsius, Temperature in Fahrenheit,
Date, and Day of the week.

When a Time/Temp frame is added, certain control become
disabled (such as, Travel, Invert Colors, Custom Justification,
and Multiple Rows). Each Time/Temp frame will display a
“Textual Placeholder” that will represent what will be
displayed on the sign. The sign’s electronics and operating
system will dynamically place the appropriate value into these
“placeholders” when the message is being played.

Custom Justification

When using “Custom Justification”, certain features become
disabled (namely “travel mode”). This feature is designed to
allow you to enter varied fonts within row.

Effects Selection

 

 

 

 

 

 

 

The Effects Selection dialog allows you to control the ON,
HOLD, and OFF effects for this frame.

There are more than 50 effects to choose from. By default,
the selection is “CHANGE”, “HOLD”, and “NONE” for the ON,
HOLD, and OFF effects respectively.

Depending upon the sign, the duration of the certain effects
can be altered. For the H20/H21 controller based signs, both
the ON and OFF effects have fixed durations. However, in all
cases, the HOLD effect’s duration can be changed.
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When you double-click the mouse over the duration for the
HOLD effect, the “Enter Duration” dialog will appear. You can
control the effects time by seconds and milliseconds. The
fineness of this control is dependent upon the sign’s controller
and the select effect.

 

Travel Settings

The Travel Effect Settings dialog allows you to control the
travel speed and direction for a frame. The Travel Mode can be set or
not set per row. However, the speed and direction of travel is common
for all rows within the frame.

There are several predefined speed selections. These are accessed by
selecting “Normal Selection” and then choosing one of the speeds
within the pull-down list.

If you wish to set the speed to another value, then select “Advanced
Selection” and choose the distance of each travel step and the time to
hold the image at each step. The speed is shown as a guideline to how
fast the text will travel.

 

 

VIEW MENU

The View menu gives you access to the functions that control the
view region and the view of the selected sign’s information.

Zoom Level  allows you to set the “size” of the view region.
There are 6 preset zoom levels that are enabled based on the
screen resolution of your monitor and the size of the sign. The
“Auto” level is a maximum zoom level.

Line Divider  allows you to toggle the presence of a “yellow line”
within the view region. The line can assist you in “viewing” the
row regions within the sign. The yellow line will not appear within
the message when displayed on the sign.

Sign Info  displays information about the sign.
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Sign Info

As shown on the right, basic information about the sign is
displayed in the Sign Information dialog. The information
displayed is equivalent to the information set when the sign
was created in Vision Setup.

For more information on the setting up of a sign, please refer
to the main Vision Setup help.

 

 

 

 

 

 

 

 

 

 

 

TOOLS MENU

The Tool menu gives you access to “tools” for Vision Quick Text.

File Convert  launches the new Vision Quick Text Converter. It allows you to
convert one version of a VMG file to another.

Options  allows you control over certain default settings for Vision Quick Text.
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Options

The Options dialog now has two sections; General and
Defaults.

The General section allows you to control the basic operation
and display of Vision Quick Text.

The Defaults section allows you to preset the default settings
for each frame. When a new frame is generated, these
settings will automatically be used.

It should be noted that the “Travel Settings” preset only set
the speed for the traveling effect for each new frame. The
travel mode must still be set for a row for these settings to
take affect.

These settings are only the initial settings. They can be
changed manually for each and every frame.

Below is a list of all of the acceleration keys for access to
various features.

FAST KEYS

  CTRL+N New

  CTRL+O Open

  CTRL+S Save

  CTRL+P Preview

  

  CTRL+SHIFT+F8 Clear All

  F8 Next Row

  SHIFT+F8 Previous Row

  F7 Invert Colors (for current row)

  CTRL+E Effects (display Effect dialog)
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  CTRL+T Travel (display Travel Settings dialog)

  

  CTRL+L Line Divider (toggle on/off)

  CTRL+I Sign Info (display Sign Info dialog)

  

  CTRL+7 Top-Left Justification (for current row)

  CTRL+4 Middle-Left Justification (for current row)

  CTRL+1 Bottom-Left Justification (for current row)

  CTRL+8 Top-Center Justification (for current row)

  CTRL+5 Middle-Center Justification (for current row)

  CTRL+2 Bottom-Center Justification (for current row)

  CTRL+9 Top-Right Justification (for current row)

  CTRL+6 Middle-Right Justification (for current row)

  CTRL+3 Bottom-Right Justification (for current row)
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OVERVIEW

Vision Schedule is the drag and drop message scheduler. It
allows you to assemble a schedule of any type of LED
message for a specific sign type, and export the messages to
that sign for download to the sign itself. Vision Schedule
allows you to schedule simple main loop content, as well as
time restricted content that play only on specific days of the
week, or specific date ranges or time ranges. When your
schedule is ready, you can export the schedule in a format
that is applicable to the specific sign you’ve chosen, and
allow Vision Update to transfer the exported content to the
sign.

 

 

 

 

 

 

HOW VISION SCHEDULE WORKS

The following is a list of key features and a brief explanation of them:

• Vision Schedule utilizes Vision Edit and Vision Quick Text files (extensions VED and VMG, respectively) as
input media to schedule. These media elements can then be arranged in a number of different manners:

• Continuous : each media element in a continuous section will automatically run in a loop unless
interrupted by a time restricted schedule.

• Time Restricted : each media element in a time-restricted section will loop only during its prescribed
execution time and/or date range. Time restrictions include days of the week, a date range, or a time
range.

• Vision Schedule will also allow for interaction with the sign itself, to perform operations such as switching
between digital content (VED or VMG messages) or live video content (from a camera or video source). Vision
Schedule will also allow for the ability to schedule automated reboots of the remote sign computer as well as
the ability to brighten or dim the display at the remote sign via easy to use configuration options.

• Schedules can be printed so that hard copies of scheduled content can be generated.
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• Vision Schedule allows messages to be previewed prior to use. This allows you to ensure that the message
you wish to use has been edited appropriately before adding it to a schedule.

• Vision Schedule uses simple drag and drop technology, allowing you to insert messages from the file list-box
into the schedule as often as required.

To get a quick understanding of the basic features of Vision Schedule, please review the Examples below or go
through the Tutorial .

OPENING VISION SCHEDULE

Vision Schedule starts up with an empty workspace, as
shown below. Upon startup, you may click the NEW toolbar
icon to create a fresh schedule, or click the OPEN toolbar
icon to load an existing schedule. All other application options
are disabled until an editing session begins.

Vision Schedule can create a blank, fresh schedule. Since a
schedule must be designed to accept media elements that
match the basic characteristics of a given sign, the first task
is to specify the sign type you are designing a schedule for.
Note that the specific sign you select isn’t recorded in the
Vision Schedule .VSF output file. Instead, three important
sign characteristics are obtained.

• Sign width in pixels.

• Sign height in pixels.

• Sign color palette characteristics.

These three pieces are obtained by clicking the NEW
message toolbar icon, or selecting File | New from the main
menu. The standard VisionSuite Sign Selector will appear.
Choose an existing sign that matches the characteristics you
wish to design for.

Once you’ve selected the sign’s properties that you wish to design for, a blank schedule editor window will appear.

Note that if you have only one sign type, the above dialog will not appear, as there is no need to request a sign type in
this situation. This is a simplification to help streamline the software.



User Manual VisionSuite Vision Schedule

Version 3.1 77

CREATING A SCHEDULE

The schedule editor window is broken into two main working
areas:

• The file listing box (top half of window), and

• The drag and drop scheduler (bottom half of
window).

Vision Schedule will display the files of a given folder, from
the selection you make in the folder selector portion of the
Vision Schedule editing window. Click the “…” button to open
a folder browser, and locate the folder that contains your
messages. Vision Schedule will always open the folder you
last selected. The file listing will only show files that match the
characteristics of the sign you are scheduling. Thus, if you
are working on an 80x16 red monochrome sign, only VED
and VMG files that match that specification will be shown, as
obviously, it makes no sense to schedule inappropriate
media.

Once a folder has been selected, you may see a display
similar to the one shown to the right.

It is useful at this point to save your work if you haven’t
already done so. Choose the SAVE button on the toolbar, or choose File | Save to invoke the save operation. If the
schedule has never been saved before, you will be prompted for a new filename. Type in the name and select the
folder you wish to save the schedule to, for example, C:\HDD\MESSAGES and click OK to save after the first save,
subsequent save operations will no longer ask for a filename. You can change the name of the file at any time by using
File | Save As and entering a new name or destination.

You cannot add new files to the file listing manually. If you need to refresh the display, open the folder browser and
locate the same folder again.

Once you’ve saved your work, you will need to re-save your work whenever you make a change to your schedule.
Changes include the adding, removing or adjusting the order of elements in the schedule.

LOADING A SCHEDULE

Vision Schedule can also load an existing schedule for
editing. Select the OPEN button on the toolbar, or use the
File | Open menu to select an existing Vision Schedule file
(VSF).

Upon loading a schedule, a window will appear showing the
file listing of the currently selected folder, and any scheduled
elements already in their correct order.

As above, all of the schedule-editing features are available,
including cut, copy, paste, and of course, saving your efforts.
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EDITING A SCHEDULE

Once the file listing is showing the media elements you wish
to work with, you may begin to populate a schedule.

As described earlier in this document, there are two main
scheduling approaches:

• Continuous schedule: all elements in this section of
the schedule will loop repeatedly from first to last
element, unless superseded by a time/date restricted
element.

• Time/Date Restricted schedule: all elements in a
given time/date restriction will only play according to
the rules you provide.

The schedule is automatically pre-populated with one
element by default: a marker indicating the start of the
Continuous schedule section. This element cannot be
removed or edited, as every schedule must contain a
continuous section.

 

To populate this schedule, drag any of the file listing
elements into the schedule, wherever you see the “arrow”
marker. The arrow indicates the direction the schedule flows,
and when the schedule reaches the last element in a given
section, it will loop back to the first element in that section
and repeat again. As you move the drag cursor overtop of
these arrows, when you have located a valid insertion point,
the drag cursor will change from a circle with a line through it,
to a “plus” symbol indicating that the element can be added to
the schedule at this point. If you decide to not drop the
element, or you wish to cancel the insertion, simply move the
cursor off of the arrow icons marking the insertion points, and
release your left mouse button to abort the insertion.

You may also shuffle any of the elements in the schedule.
Simply click and drag any element and locate an insertion
point where you would like to drop the element. Once
dropped, the schedule will remember the new order of the
elements.

As elements are either inserted or moved, the drag-drop
editor will always attempt to keep the highlighted current
element in the visible portion of the editor. This is done
because it is more than likely the next element for a schedule will be added either in front of or after highlighted
element.

You can click once on any schedule element to make it the “current element”, or you can also use your arrow keys
when the drag-drop editor has the keyboard focus to move the highlight bar to locate a new “current schedule
element”. Once an element is deemed “current”, you can use the keyboard DELETE key, or the Edit menu to remove,
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cut, copy or paste elements at this spot in the schedule. You may also use the REMOVE ELEMENT button in the
scheduling window to remove the currently highlighted element. As indicated earlier, the Continuous element cannot
be removed.

Each section will be denoted visually through the use of an
alternating light gray or dark gray bar placed vertically at the
left edge of the drag-drop editor. When you add a new
time/date restriction into a schedule, the visual indicator will
flip to visually illustrate at a glance that the media elements
that follow belong to a different schedule section.

 

 

 

 

 

 

 

 

To add a new schedule restriction, locate an appropriate
insertion spot to add a new schedule element to the
schedule. The schedule element will be added after the
currently highlighted element, thus, it’s more than likely that
new schedule elements are going to be added to the end of a
schedule, however, this is not enforced.

Remember that any media elements added after this
schedule element will all exhibit the restrictions imposed by
this schedule element. Hence, you can have any number of
media elements that will play within the restriction imposed by
this schedule element. To edit the time and date restrictions,
highlight a schedule element, and select the EDIT
SCHEDULE ELEMENT button, or simply double click on the
appropriate schedule element itself.

There are two types of scheduling; Block and Continuous
modes. By default, Block mode will appear in the Configure
Time/Date Restrictions dialog.

Block mode , as the top-right icon indicates, means that the
event is schedule every day between specific times.
Continuous mode  means that the event is schedule from
start time & date to end time & date. Depending upon how you want to schedule events, one method may be better
than the other.
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One has control over the following items;

• Days of the week.

• Start and End Date

• Start and End Time

The image to the right is showing the Continuous mode; the
previous image above shows Block mode.

Note that you can remove a schedule element by simply
highlighting it, and using the REMOVE button, or using your
DELETE key on your keyboard.

 

 

 

 

Continue to populate the drag-drop schedule editor with both
media elements and schedule elements until you feel you
have the schedule set up appropriately. At any time, feel free
to use the File | Print option to generate a web based report
of your schedule, which you can then save as an HTML file
on disk, or print as a hard copy. This allows you to distribute
a report of your schedule to other people by simply using the
web browser’s “Send” option to email or save the file to
another destination.
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Next to the schedule listing, you will find an area that indicates where messages are
to be selected from; the Current Folder . By default, Vision Schedule will always start
up in the [InstallFolder]\MESSAGES, where messages are normally saved by Vision
Edit or Vision Quick Text.

By clicking the “…” button, Vision Schedule will pop up the standard Windows folder
browser. You may select any drive/folder combination where VisionSuite compatible
messages may be stored.

When you OK your folder selection, the Current Folder selector will display the drive
and folder name you have chosen. In addition, the hopper will reload the available
compatible messages for the sign type you are scheduling for. Thus, if you are
scheduling for a 32x16 Red Monochrome sign, only messages in the selected folder
that match that sign type will appear in the hopper. This ensures that you are only
able to schedule messages that are appropriate for the current sign type.

 

 

SPECIAL ELEMENTS

Vision Schedule is also capable of scheduling three other
types of elements:

• Reboot of sign computer

• Switch to Live Video

• Adjustment of sign computer visual properties such
as brightness, etc.

These elements are mostly intended for higher-end video
systems.

These elements can be displayed in the file selector by
ensuring that files by these extensions appear in the currently
selected folder:

[filename].RB  – this is a reboot file. It is a trigger that can
be used to force the remote sign controller to reboot on a
scheduled basis. Note that none of the currently
supported sign types for HDD can use this feature, as it is
meant for future compatibility.

[filename].LV  – this is a live video file. It contains simple text configuration data as follows:

[config]
duration=30

The above shows the Windows INI style configuration for the live video. It indicates that this object will force a
switch to live video, and run the live video for a total of 30 seconds.

[filename].DC  – this is a Display Control file, and can be used to specify brightness and contrast settings for
the sign controller. As with the live video object, you can use a Windows INI file specification as follows:
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[config]
duration=1
brightness=75
contrast=60
extra=

The values shown above are percentage of their full values, with a minimum to maximum range of 0 to 100%.
Note that you do not need to specify the percent symbol, as the percentage is implied. The extra field will allow
for expansion of this capability in the future.

As with Vision Edit and Vision Quick Text media elements, simply drag and drop these elements into the schedule so
that they will perform their operations at the desired time. Obviously, elements such as a Reboot element should be
used only sparingly and at off-hours, to avoid visual interruptions on the remote sign computer and to avoid having a
chance that many observers will witness the restart of the computer.

FILE MENU

The File menu gives you access to the basic functions that
control & maintain the file that you are working on.

New allows you to create a new Vision Schedule file.

Open  allows you to open an already existing Vision Schedule
file.

Save allows you to save the file you’re currently working on.
When Export with Save is checked off, the schedule and media
files will also be exported.

Save As  allows you to save the file you’re currently working on
as a different name.

Close  allows you to close the current Vision Schedule file
without exiting the application.

Export Schedule and Media  will cause Vision Schedule to
render the appropriate schedule and message files for the
selected sign. The rendered files will automatically be stored
into a special folder on your PC for Vision Update to refer to
when you update your sign.

One Touch Update  will automatically launch Vision Update and connect you to the sign that you’ve assigned for the
current schedule.

Print  allows you to print a basic report on the various elements within the schedule.

Preview Schedule  allows you to preview the schedule on a specific time and date.

Most Recently Used  file list allows you to select one of the previous four files that you have been working on.

Exit  closes Vision Schedule.
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Open/Save/Save As

Whether you use Open, Save or Save As, the common File
Dialog will appear (shown to the right). The title and the
button will be named appropriately.

Note that all Vision Schedule files have the file extension of
VSF.

Export Schedule and Media

Vision Schedule builds schedule information, however it
cannot talk directly to the remote sign, because each HDD
remote sign product has their own particular communications
schemes and requirements. Part of these requirements is the
necessity to convert VisionSuite data into files that are
backward or forward compatible with the hardware you wish
to send data to. Thus, Vision Schedule is required to perform
one final processing step on your scheduled data: EXPORT.

When you are ready to convert your scheduled information to data applicable to your remote signage, choose the File |
Export Schedule and Media menu option. This option will first request you for a specific sign type that matches the
characteristics of the schedule you have designed for. Note that if you only have one sign type that matches the
characteristics of schedule; no dialog will appear asking you for the sign. This final step will extract from the sign
database all of the export knowledge that will be needed by Vision Suite to ensure that Vision Schedule schedules,
and Vision Edit and Vision Quick Text media elements can be converted correctly into outgoing data for the sign itself.

Once a sign is established, a series of dialogs will appear indicating the process of the export. If any errors are
detected, warning dialogs will appear indicating what the problems may be.

If all is successful, no error or warning messages will appear. In a future version, Vision Schedule will immediately
launch Vision Update so that this data can be transferred to the sign after export is completed. Currently, if all is well,
you will have to use the Vision Suite startup window to launch Vision Update. The exported content is not required for
the operation of Vision Edit, Vision Quick Text or Vision Schedule. It is only required for Vision Update to send to the
remote sign.

By default, Vision Schedule will always automatically do an export when you save your work. This feature can be
enabled or disabled using the File | Export With Save menu selection. A checkmark will appear to indicate whether the
feature is on or off at any given moment.

If you have multiple sign types with similar characteristics, you will be required to select the sign type for export
purposes. If this is the case, you may wish to disable the Export With Save option to avoid unnecessary sign type
selection whenever you save your work, however, you will then need to manually select the Export option to generate
data compatible with the physical signage.
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One Touch Update

Vision Schedule contains the ability to automatically update
your desired signage with the schedule you are currently
editing. First, save and export your current work. When this
task is completed to your satisfaction, and you have
optionally previewed your schedule to ensure it is what you
desire, you may choose the File | One Touch Update option
(or choose the One Touch Update toolbar button, located
beside the Help icon on the toolbar).

This feature will automatically invoke the Vision Update
program and begin the job of transferring the exported
schedule and media files to the sign designated by the export
operation. This minimizes the effort for VisionSuite
considerably, as you are now easily able to navigate from
message creation straight through to sign updates using this
path:

Vision Edit è One Touch Scheduleè Vision Scheduleè
Automatic Export è One Touch Updateè Vision Update

Note that One Touch Update may request for the sign you are updating if multiple signs of the same characteristics as
the schedule exist. This is the same process you follow when performing an export.

Preview Schedule

Vision Schedule has a handy feature that will simulate what the expected
message loop will be at any given day and time. Click the File menu, and
choose Preview Schedule. A dialog box similar to the one to the right is
shown.

This dialog will allow you to choose the day of the year, as well as the time
of day for the simulation.
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Based on the selection, Vision Schedule will scan the
schedule and its internal time restrictions, and determine the
minimum list of files that will play at the date and time
selected. You will then see a dialog box similar to the one on
the right.

From this dialog box, you can select to preview all of the files
in Vision Preview. The preview window will show each
message one at a time, and loop back to the start of the play
list when complete. You will note that the Preview window will
have a “skip” button to allow you to jump to the next message
in the play list to quickly scan through your messages.

You can select how much of the list is previewed by entering
a value in the edit box. Note that you cannot preview zero
messages, or more than the total in the list. Vision Schedule
will correct your values and proceed to preview the entire list
for you.

Note that you may be faced with a situation where no files are
available for preview. This may be due to a schedule that has
no continuously playing members, with schedule restrictions
that prevent messages from playing at specific times of the
day. Since the real LED sign will show black at this time, it
isn’t useful to generate a “black” preview, and hence, a
warning message will appear informing you of this situation.
This warning is invoked to ensure that you are aware of this
situation and that if the schedule was built erroneously, that you will have an opportunity to correct this schedule before
exporting.

Note that reboot, live video and display control members of this list cannot be previewed, as they have no apparent
visual connotation in terms of message playback. Thus, do not be surprised if the preview window displays warnings
about missing message content in that situation! .

Exit

You can exit the application by one of two methods. First, you
can select “Exit” from the File menu. Second, you can press
the “X” (close) button at the top right of the application or
current file. In either case, you will see one of the dialogs
shown to the right.
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EDIT MENU

The Edit menu gives you access to functions that control the
“how” you edit objects within list of scheduled items.

Cut, Copy, Paste, and Delete  selections are the standard
functions that exist within most editing applications.

Edit Object  will automatically launch Vision Edit or Vision Quick
Text for the appropriate media file that you have just selected.
For other special elements, the appropriate dialog box will open
to allow you to edit the items.

Preview Object  will automatically launch the preview the
window for the selected file.

VIEW MENU

The View menu gives you access to user interface features.

Toolbar  shows you a set of small icons at the top portion of the
main window. These icons are short cuts to various features
within Vision Schedule.

Status Bar  shows you a variety of information at the bottom of the main window .

SETTINGS MENU

The Settings menu gives you access to certain special features.

Export With Save  will cause Vision Schedule to export the
schedule and media files when the current schedule is saved.
By default, this is checked.

Dither/Halftone During Rendering  will instruct the rendering process to generate "dithered" colors when generating
messages for monochromatic signs. This may be useful if your sign is a high-resolution monochromatic display and
you wish to display colored images.

FAST KEYS

Below is a list of all of the acceleration keys for access to various features:

  CTRL+N New

  CTRL+O Open

  CTRL+S Save

  CTRL+E Export schedule and media

  CTRL+U One Touch Update
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  CTRL+P Print

  

  CTRL+Z Undo

  CTRL+X Cut

  CTRL+C Copy

  CTRL+V Paste

  DEL Delete selection object from schedule list

  CTRL+D Edit Object

SUPPORT FOR 24-BIT HDDVISION TIME/TEMP ELEMENTS

As noted in the Vision Edit documentation, VisionSuite will not export TTN keyframes when exporting for the 24bit
HDDVision brand of signage.

To get around this particular limitation, the following work around will apply.

• Use the original 16-bit VisEdit message editor supplied with your HDDVision signage to create 3 specific files
of these filenames:

• VPYTIME.VPY - a message that contains ONLY a time TTN element

• VPYTEMPC.VPY - a message that contains ONLY a Celsius temperature

• VPYTEMPF.VPY - a message that contains ONLY a Fahrenheit temperature

• Save these VPY files into the folder ASSETS, located inside your installation folder for VisionSuite (for
example, C:\HDD\ASSETS). These files are essentially deemed as “pre-exported” data for 24-bit HDDVision
sign exports.

• Now that you have TTN elements available as pre-exported data, you can insert media elements into your
schedule that will “tie in” with these assets. Use Vision Edit to create 3 dummy (empty) VED files with these
filenames:

• VPYTIME.VED - this ties in with the VPYTIME.VPY file above

• VPYTEMPC.VED - this ties in with the VPYTEMPC.VPY file above

• VPYTEMPF.VED - this ties in with the VPYTEMPF.VPY file above

Save these files wherever you normally save your VED files (in the MESSAGES folder, for example). They will
now become files you can drag and drop as normal.

• When you drag and drop any of these 3 filenames into the schedule, Vision Schedule will automatically copy
the pre-exported VPY files from above into the EXPORT folder, thus, giving 24-bit HDDVision signage the TTN
elements it requires.

• You are free to change the look and feel of the pre-exported VPY files using the older 16-bit VisEdit editor.
However, only these 3 special files are used, and there will be no provision for further expansion of this
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capability as 24-bit HDDVision signage will be phased out and replaced by more powerful video signage in the
future.

TROUBLESHOOTING

Vision Schedule is a robust drag & drop capable editor that completely simplifies the day to day control of scheduling
content on a remote sign computer. Modern techniques are employed to ensure that you do not need a large amount
of training to perform scheduling operations, however, from time to time, certain issues or problems may arise. Note
that these are not errors per-se, however, to the novice user, they may appear as errors, and hence, this section will
highlight common editing issues.

No exported data from Vision Edit message.

Vision Schedule does not verify the contents of any media element, hence, it may be possible to schedule an
element that has no exportable content!

This can be generated in a couple of ways. The Vision Edit file itself may have no key-frames of content.
Without content, there can be no exported data for the remote sign!

Another potential issue here is that the key-frame effect may be a combination of “NONE” for the ON effect, or
a HOLD duration of ZERO seconds. Since these values are a signal to the remote sign that nothing is to be
played for the key-frame in question, this may cause an export attempt to not create any exported content.
Simply adjust the ON effect and/or duration to nominal values and try your export again.

Note that the ON effect of NONE is used to indicate that a key-frame has no visual appearance. This is a
convenient way to indicate that a given key-frame will be used as either an animation frame (thus controlled
via the animation editor), or as a background or foreground frame to be used with another bitmap effect or a
TTN frame.

A similar issue may arise with Vision Quick Text data. If the effect or time duration settings for a VMG file are
such that nothing can be exported, warnings will be issued to inform of such an event.

Remember that Vision Edit and Vision Quick Text messages with TTN data being exported for 24bit
HDDVision signage will not generate TTN keyframes in the export, therefore use the workaround discussed
earlier in this document to work around this issue.

How can I set my schedule to only run one day a wee k at lunchtime?

As discussed earlier, a time/date restriction will be required. Since there is no date range associated with this
restriction, set the calendar date range to start at the beginning of the year and end at the end of the year.
Current HDD hardware does not use calendar year information, hence, this approach ensures that every week
of the year will be covered using a start/end date of the two extremes of the year. Similarly, if a file is meant to
run from the start to the end of a given day, set the time range from midnight to 11:59PM to ensure coverage
for the entire day.

The remote sign computer is rebooting continuously.

More than likely, you have inadvertently set up a REBOOT object to run as part of the continuous schedule.
Create a time/date restriction, and set up the reboot object to run in a very narrow time range. For example, if
you wish the remote sign computer to reboot daily at 4:00 AM (when hopefully there are very few people
around to witness the reboot), set up a time/date restriction to run on a daily basis, each day of the year, and
set the time restriction to 4:00AM to 4:01AM. This ensures that when this time is reached, the sign computer
can trigger a reboot. The rebooting process will always take a couple of minutes to achieve, hence, a 1-minute
duration is more than sufficient to trigger such an event. Ensure that your current folder has a reboot file (a file
ending with .RB) and drag it after the newly created time/date restriction. The reboot will now occur at the
specified time .
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INTRODUCTION

'Vision Setup Wizard'  allows one to set up a sign in a simple, step-by-step manner. 'Vision Setup Wizard'  is meant
to handle the most common types of signs. If the sign to be setup is older or very specialized, it is possible that its
characteristics will not be covered by the options presented in this Wizard. In that case, it will be necessary to run
'Vision Setup'  (press 'Cancel'  at any time to exit 'Vision Setup Wizard' ).

Before commencing, it would be helpful to gather information about the sign. Read through this section to get an idea
of what information is required.

WELCOME TO VISION SETUP WIZARD

This preliminary step describes how to use the Wizard.

Pressing 'Next'  will advance to the next step of the Wizard. The
program will alert you if any of the information is missing or
incorrect.

Pressing 'Back'  will go back to the previous step of the Wizard.

Pressing 'Cancel'  at any time allows you to exit the program
without setting up the sign.

 

 

 

 



Vision Setup Wizard VisionSuite User Manual

90 Version 3.1

STEP 1: IDENTIFICATION

In this step you must give the sign a name and identify its type.

Sign Name  - Give the sign a name. Note: the program disables
characters not allowed in a name.

Sign Type  - There are two options for sign type:

Choose 'Vision Max - H21'  (the most common type) unless the
sign can display 256 shades of one color or full color (i.e., millions
of colors). In that case, choose 'Vision Max - H22' .

 

 

 

 

STEP 2: CHARACTERISTICS

In this step you must specify the number of pixels wide and high,
and the pixel color(s).

Model Number  - This information is optional. If you enter the
model number of the sign, for example 18HDD72X16, the Wizard
will automatically extract the number of pixels wide and high.

Width in Pixels  - Enter the number of pixels the sign has from
left to right.

Height in Pixels  - Enter the number of pixels the sign has from
top to bottom.

Color Scheme  - Choose the option that describes the color or
colors the sign can display.
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STEP 3: CONNECTION TYPE

In this step you must specify how the sign is connected to your
computer.

Standard Serial (RS-232)  - Choose this option if the sign is
connected directly to your computer via an RS-232 serial port. An
RS-232 serial port is usually a nine-pin connector found on the
back of your computer. Alternately, the sign could be connected
via an RS-232 converter connected to a USB port.

Industrial Serial (RS-485)  - Choose this option if the sign is
connected to your computer via an RS-485 connection. This
method of connection is used when the distance to the sign is
greater than 20 feet. If the sign is connected via RS-485, the
cable coming from the sign will be attached to a small beige box.
The box in turn will be connected to the computer. The box will
be labeled 'Transio Moxa A53' or something similar.

Modem  - If the sign is connected via a telephone line, choose this option.

RF Transceiver (Wireless)  - If there is a wireless connection to the sign, choose this option. Somewhere in the vicinity
of the computer will be a small box with an antenna attached.

STEP 4: CONNECTION DETAILS

In this step you must give further details about the connection to
the sign. Note: depending on the type of connection that was
previously selected, some of the options below might not be
present.

Serial Port  - No matter what connection type was selected in the
previous step, all must eventually connect to the computer via a
serial port. If you are unsure which 'COM'  port to select, select
'COM1' . If you are using a Serial-to-USB  converter, select the
highest available 'COM'  port. If the selection is incorrect, it can
always be changed later by running 'Vision Setup' .

Baud Rate  - 'Baud Rate'  is the connection speed to the sign. In
most cases, there will only be one available baud rate. If there is
more than one selection and you are unsure which to choose,
select the lowest baud rate.

Address  - If more than one sign is connected to a port on the computer, each sign must have a different address. The
address of a sign is set at the factory or during installation. If a sign is addressed, it will display its address briefly when
first powered on. Enter that number here. If there is only one sign connected, leave the address at '0' .

Phone Number  - If the sign is connected via modem, enter its phone number here. Brackets and dashes are not
required (however, be sure to enter a '1'  and/or the area code if required).

Land Line/Cell Modem  - Select the appropriate option for the type of phone connection to the sign.
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STEP 5: PHOTOCELL

In this step you must specify whether or not a photocell is
connected to the sign.

A photocell allows the sign to dim during the night for both clarity
and power savings. Most signs have photocells attached, so if
unsure, select 'Yes' .

 

 

 

 

 

 

FINAL STEP: SUMMARY

After the steps have been completed, a summary of all sign
information will be shown. Take this opportunity to verify that
everything is correct. If not, press 'Back'  one or more times to
reach the step in question and correct the settings as needed.

If all information is correct, press 'Finish' . The sign will be saved
for use with other applications in 'VisionSuite' .
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OVERVIEW

Vision Update is the core application for updating your sign
with new messages and a new schedule. Vision Update
provides a straightforward user interfaces to quickly view the
sign’s current messages, examine the new schedule, view
the list of messages, and to update the sign appropriately.

Vision Update is designed as an updating system for only
Message signs. Updating Video Systems is accomplished by
other means due to the uniqueness of the video systems.

 

 

 

 

 

 

HOW VISION UPDATE WORKS

When the main window is opening, Vision Update will automatically connect the sign that you’ve selected and will
automatically scan the Export folder where the “to be sent” files are located. Once you are connected to the sign, you
can update the sign by simply pressing a Send button. Depending upon the type of communication connection you
have to the sign, the rate of updating the sign will vary.

The menu items give you access to various functions to examine the schedule and message list, the files at the sign,
and entering passwords for control & access to the sign.

To get a quick understanding of the basic features of Vision Update, please review the Examples below or go through
the Tutorial.

Vision Update's sole purpose is for updating the sign with new messages and a new schedule. It is not intended for
complex diagnostics or sign maintenance. For more advanced sign control, please refer to the main Vision Setup help.
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OPENING VISION UPDATE

When more than one sign has been configured for your PC,
you will see this dialog each time you open a VisionSuite
application. If you only have one sign configured for your PC,
then it will automatically load as the sign to use. Therefore,
you will not see this dialog.

Once the sign has been selected, all of its capabilities are
automatically loaded into Vision Update. The characteristics
of the sign are taken into account and the application
customizes its interface for the sign.

Vision Update can be launched in two different ways. First, by
selecting the Vision Update button from within the main
VisionSuite window. Second, by selection “One Touch
Update” within Vision Schedule. When One Touch Update is
selected, you will not see the Sign Selection dialog since
Vision Update automatically knows which sign your schedule
file has been created for.

When CANCEL is pressed, Vision Update will not open and
you will be returned to the main VisionSuite window.

THE MAIN WINDOW

The main Vision Update window has several regions.

The Update  region shows the name of the new schedule, the
type of update process, and the status of the update.

The Status  region displays the file information on the
schedule and messages that need to be sent, the currently
playing schedule & message, the current time and date at the
sign, and the memory of the sign.

The Send (or Start)  button which allows you to start the
transmission of the files to the sign.

The Communication Status  region which displays
information about the transmissions between the PC and the
sign.
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Update Region

The Update region states the name of the sign, the name of the new schedule, the
type of update method (manual or batch modes), the type of “send” operation
(currently defaults to SEND ALL FILES), and the status of the update process.
Some sign systems will have additional information after these core items.

 

 

 

 

 

Status Region

This region shows the number of files to be sent, the amount of memory
required to send the files, the currently playing schedule & message, the
current date & time, and the total & available memory at the sign’s
electronic controller.

This information is useful for diagnostic purposes:

• Is there enough memory at the sign for the message?

• Is the sign currently running?

• Does the number of files seem reasonable given the schedule
that I just saved?

When sending the data, the software will only validate the size of the
files. The information provided will verify that you’re updating the sign
with the correct files.

The Operational Time section contains the amount of time left
for the sign before an AuthorizationCode must be entered.

Ten days  (and less) before the “time” expires, a message
box will appear whenever the user connects to the sign.
Once the time expires, the sign will no longer resp ond to
updates and the current schedule will stop running.
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Send/Start Button Region

Vision Update operates in two modes; Manual and Batch
modes. The button will be labeled as “SEND” when in Manual
mode. You can enter into Batch mode by selecting Batch
Updates from the Tools menu (see below for more
information). When in Batch mode the Send button is
renamed to “Start”.

Vision Update will update the sign in the following manner:

• Stop the Current Schedule

• Delete all files (or specific files)

• Transmit the New Schedule

• Start the New Schedule

• Transmit the New Messages

• Obtain the New File Information

Using this methodology, the sign will start playing the first message that arrives at the sign. This means that the sign is
blank for the minimum amount of time.

Communication Status Region

As in Vision Setup, this section displays the status of the connection from
the PC to the sign. For more information, please refer to the Vision Setup
help.

 

 

 

FILE MENU

The File menu gives you access to two items:

Select Sign  allows you to select a new sign. If you have several different signs (different
matrix size and/or color), then you can use this function to access the Sign Selection dialog.
Once selected, Vision Update will disconnect from the current sign and reconnect to the new
sign. The new schedule file from the appropriate Export folder will also be read.

Exit  closes Vision Update.



User Manual VisionSuite Vision Update

Version 3.1 97

Exit

You can exit the application by one of two methods. First, you
can select “Exit” from the File menu. Second, you can press the
“X” (close) button at the top right of the application. In the
second case, a similar dialog as shown to the right appears to
ensure that you want to close. By purposely selecting the “Exit”
from the File menu, you can bypass this dialog.

 

 

VIEW MENU

The View menu gives you access to various information.

Schedule  will display the “text version” of the schedule that will be transmitted
to the sign.

Messages  will display a list of the files within the Export folder that will be
transmitted to the sign.

Sign Parameters  displays the current information about the sign.

Sign Settings  displays the some of the sign’s settings saved within Vision Setup.

Messages

As shown on the right, the list of files is displayed in a very basic manner.

Notice that the names are not the same as those within Vision Schedule.
During the “export” of the schedule, the message names are truncated for
certain types of signs. Some signs have a limit of 8 characters for message
and schedule file names.
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Sign Parameters

As shown on the right, the current settings of the ONLINE
sign are displayed. This is a much more detailed list of
information compared to the information shown in the main
window.

For more information on the setting up of a sign, please refer
to the main Vision Setup help.

 

 

 

 

 

 

 

 

 

 

Sign Settings

As shown on the right, most of the basic information about
the sign is displayed. The information displayed is equivalent
to the information set when the sign was created in Vision
Setup.

For more information on the setting up of a sign, please refer
to the main Vision Setup help.
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TOOLS MENU

The Tool menu gives you access to the following items:

Batch Updates : Select signs to update at some time in the
near future.

Exit Batch Mode : Exits from batch mode so that Vision
Update goes back to the behaviour of updating one selected
sign when "Send" is pressed.

Connect to Sign : Connect to an OFFLINE sign.

Disconnect from Sign : Disconnect from the current ONLINE
sign.

View List of Files on Sign : Presents a list of all files on the
selected sign, including schedule and content.

Hardware Password : Enter the hardware password for the
sign. This value has also been setup in Vision Setup and
saved to the sign.

Test Communications : Run the standard Test Communications tool in order to verify connection to the sign.

Refresh : Update the “Status” region information on the main window.

Options : Control the options for this application.

Batch Updates

The Batch mode is a new feature to VisionSuite 3.0. It has
been designed for updating signage at times that are more
convenient for the user.

You can setup a time and date to run the batch process. You
can update as many signs as required. Each sign is
processed one at a time. If a sign fails to update, the batch
process will continue to the next sign.

Press Add to select a new sign for the batch process. Move
Up and Move Down will change the order of the signs. Delete
will remove the sign from the list.

It is very important to make sure that the schedule and
messages have been saved properly prior to running the
Batch Setup.

Pressing File then Save Batch File saves the currently
selected signs and schedules for later recall. Pressing File then Load Batch File loads a previously saved batch file.
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Pressing Edit then Clear List clears the list of signs. Previous versions of Vision Update could not update signs in
batch mode when the signs had hardware passwords. This has been remedied in the latest version, thereby providing
greater security. Pressing Edit then Enter Hardware Passwords sets hardware passwords for selected signs.

 

Once the Batch mode signs have been selected, the SEND
button on the main window has changed to START.

By pressing the START button, the dialog on the right will
appear.

The current time will update once every 5 seconds until the
“Scheduled” time occurs.

Afterward, the batch of updates will be processed. The Status
column will indicate that the sign is being updated. Once the
update is finished, Vision Update will automatically
disconnect from the sign.

The Batch Update window will remain open until the CANCEL
or OK button is pressed.

Admin or Hardware Passwords

If the Hardware password is set, press “Hardware Password” button
and the “Password Entry” dialog will appear. The OK button
remains disabled until a password is entered. If the password is
incorrect, an appropriate message is displayed.

 

Test Communications

As in Vision Setup, the Test Communications dialog can be
used to test the connection to the sign.

For more information on the setting up of a sign, please refer
to the main Vision Setup help.
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Options

The Options selections have been greatly enhanced from the
previous versions. The list on the left indicate all of the
sections of control that are available.

The sections are as follows:

• General  – Basic control of certain operational
features of the interface.

• Sending  – Basic control on how files are sent to the
sign.

 

Options - General

The General section allows the following controls:

• Sign Name – Display the sign name in the title
bar as well as within the Update region.

• Show ONLINE – Display the sign’s ONLINE
status within the title bar.

• Automatically Close – When in Manual mode,
close the application once the update has
finished.

 

Options - Sending

The Sending section allows the following controls:

• Send All Files – This will force the software to
automatically delete all files at the sign and copy
all new files to the sign.

• Send only Selected – This will disable the
deletion of all files at the sign. Only the selected
files will be sent to the sign.

 

 

 

 

FAST KEYS

Below is a list of all of the acceleration keys for access to various features.
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  CTRL+O Select a new sign

  

  CTRL+SHIFT+V View the list of Sign Parameters

  

  CTRL+SHIFT+C Connect to the sign

  CTRL+SHIFT+D Disconnect from the sign

  CTRL+SHIFT+T Run the Test Communications

  

  F5 Refresh data within the Status Region

TROUBLESHOOTING

When Vision Update starts, it always shows that my sign is OFFLINE. What is wrong?

Several items could be wrong. Please refer to the “Troubleshooting” section within Vision Setup for more
information on this problem.

I cannot update my sign’s operating system from the  Vision Update dialog.

Updating the sign’s operating system can only be performed within Vision Setup. For more information, please
refer to the main Vision Setup help.

Where do I enter my “Authorization Code”?

Entering your AuthorizationCode (in order to turn-off the “time left” display) is done within Vision Setup. For
more information, please refer to the main Vision Setup help.

The Time Left entry is showing “Expired” even though I know I have several days left before I need to en ter in
the Authorization Code.

The sign has not expired. You have set a “Hardware Password” and you have not yet entered it. Go to the
“Hardware Password” dialog and enter your password. Once completed, the time limit will display as expected.
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OVERVIEW

Vision Step2Sign Wizard is an application that steps you
through the process of creating messages, creating a
schedule, and updating the sign. You may use Step2Sign for
all of your messaging needs or use it in combination with the
other VisionSuite applications.

Vision Step2Sign Wizard is designed as an updating system
for only Message signs. Updating Video Systems is
accomplished by other means due to the uniqueness of video
systems.

 

 

HOW VISIONSTEP2SIGN WIZARD WORKS

When the first window opens, Vision Step2Sign Wizard steps you through the process of creating & saving a schedule
and updating a sign. A simplified method of creating messages is also available. Next  and Back  buttons are present to
allow you to move between the four major steps within the Wizard.

The menu items give you access to various functions to create messages and groups of messages, access the sign
features, and setup options.

To get a quick understanding of the basic features of Vision Step2Sign Wizard, please review the Examples below or
go through the Tutorial.

For more advanced message creating and scheduling, please refer to the main help for Vision Edit, Vision Quick Text,
and Vision Schedule.
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OPENING VISIONSTEP2SIGN WIZARD

When more than one sign has been configured for your PC,
you will see this dialog each time you open a VisionSuite
application. If you only have one sign configured for your PC,
then it will automatically load as the sign to use. Therefore,
you will not see this dialog.

Once the sign has been selected, all of its capabilities are
automatically loaded into Vision Quick Text. The
characteristics of the sign are taken into account and the
application customizes its interface for the sign.

When CANCEL is pressed, Vision Quick Text will not open
and you will be returned to the main VisionSuite window.

 

 

 

THE MAIN WINDOW - STEP 1: CREATING A SCHEDULE

When Vision Step2Sign Wizard opens, the first step is the
creation of a schedule.

This window has several regions; the Common  Messages
show the auto-generated messages; the Messages  show the
user created messages; the Groups  shows the user created
groups of messages; the “Add Time/Date Restriction ”
button for adding new time/date ranges; the Operation
Buttons  for adding, removing, and moving messages; and
finally, the Active Schedule  which shows the list of
messages and time ranges.

Press the Next button to proceed to the saving of the
schedule.

Common Messages

The list of Common Messages is automatically generated the first time you open
Vision Step2Sign Wizard for the particular sign. These messages can be altered
within the Wizard.

Therefore, when you first get your sign, you will able to use these messages to create
a schedule and update the sign.
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Messages

The list of Messages is generated by the user when any messages are created or
added to Vision Step2Sign Wizard.

This list of messages resides in a special folder dedicated for the Wizard. Altering
any original “added” message will not change the file that has been added to the
Wizard.

Groups

The list of Groups is generated by the user when a new group is created (via the
Edit menu).

 

 

By pressing the “…” button, the View Group Listing dialog appears. As
shown, you can quickly view the list of files that have been added to the
selected group.

If you wish to edit the group, select the group name within the Groups list
and select the “Edit a File” from the Edit menu.
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Add Time/Date Restriction

By pressing the “Add Time/Date Restriction” button, you will
get the “Configure Time/Date Restrictions” dialog which will
allow you to enter a new time/date section to the schedule.

The top 7 checkmark buttons indicate the days of the week
you want the messages to play.

There are two types of scheduling: Block  and Continuous
modes. By default, Block mode will appear in the Configure
Time/Date Restrictions dialog.

Block mode, as the top-right icon indicates, means that the
event is scheduled every day between specific times.
Continuous mode means that the event is schedule from a
start time & date to an end time & date. Depending on how
you want to schedule events, one method may be better than
the other.

For more information, refer to the Vision Schedule help.

Operation Buttons

These four buttons allow you to add & remove files from the
Active Schedule and move files up & down the Active Schedule list.

Depending upon which file you have selected, the button automatically become enabled or disabled.

 

 

ACTIVE SCHEDULE

As within Vision Schedule, the first element within the schedule list is a
“Play Continuously” Time/Date restriction. This entry cannot be changed.
All messages underneath this entry (up to the next Time/Date restriction)
will play all the time.

The other Time/Date restriction shown in the image to the right shows the
restriction in an abbreviated format. This selection is controlled within the
Options dialog under the Tools menu.

The Time/Date restriction shows the start & end date, the days of the
week, and the start & end time within each day.
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THE MAIN WINDOW - STEP 2: SAVING A SCHEDULE

Once the schedule has been created, the next step is to save
the schedule. Depending upon the options that have been
set, this step may not show.

You can either press the SAVE button to automatically save
the schedule to a default file or select Save from the File
Menu.

Once the file has been saved, the Wizard will automatically
proceed to the next step.

 

 

When the schedule is saved without any errors, the following
message (with the appropriate sign name folder) is displayed.

This message indicates that there were no problems in rendering the
messages within the schedule for this sign.

 

 

 

 

THE MAIN WINDOW - STEP 3: UPDATING THE SIGN

This is a very basic version of Vision Update. Once the sign
connects to the sign, the SEND button will become enabled.

The Wizard is designed to automatically delete all files at the
sign before transmitting the new files. This is optional within
Vision Update.

As in Vision Update, the sections are very similar:

The Update  region shows the name of the new schedule, the
type of update process, and the status of the update.

The Status  region displays the file information on the
schedule and messages that need to be sent, the currently
playing schedule & message, the current time and date at the
sign, and the memory of the sign.

The Send  button starts transmitting files to the sign.
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The Communication Status  region displays information about transmissions between the PC and sign.

Batch Updating is not available within the Wizard.

Update Region

The Update region states the name of the sign, the name of the new schedule, the
type of update method (manual or batch modes), the type of “send” operation
(currently defaults to SEND ALL FILES), and the status of the update process.
Some sign systems will have additional information after these core items.

 

 

 

 

 

Status Region

This region shows the number of files to be sent, the amount of memory
required to send the files, the currently playing schedule & message, the
current date & time, and the total & available memory at the sign’s
electronic controller.

This information is useful for diagnostic purposes, e.g.:

• Is there enough memory at the sign for the message?

• Is the sign currently running?

• Does the number of files seem reasonable given the schedule
that I just saved?

When sending the data, the software will only validate the size of the
files. The information provided will verify that you’re updating the sign
with the correct files.

The Operational Time section displays the amount of time left
for the sign before an Authorization Code must be entered.

Ten days  (and less) before the “time” expires, a message
box will appear whenever the user connects to the sign.
Once the time expires, the sign will no longer resp ond to
updates and the current schedule will stop running.

Once the sign has been updated, the Wizard displays the
following message.

If anything goes wrong during the transmission of the new
schedule and messages, errors will display within the status
region of the window.

If errors persist, then use Vision Setup to diagnose the communications.
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Once the sign has been updated, you can press the Next button to
proceed to the final step.

 

 

 

 

THE MAIN WINDOW - STEP 4: START AGAIN OR EXIT

The final step is very simple. By pressing Start , you will
return to the first step. You can reconnect to a different sign
or even redo the schedule.

Pressing Exit  will close the application and disconnect from
the sign.

 

 

 

 

 

FILE MENU

The File menu gives you access to the basic functions for the current schedule:

New Schedule  clears the current schedule.

Load Schedule  opens a new Step2Sign Wizard schedule file.

Save Schedule  saves the current schedule.

Save As New Schedule  saves the current schedule as a different name.

Export Library  exports the entire Vision Step2Sign Wizard library to another
folder.

Select Sign  selects a new sign. If you have several different signs (different
matrix size and/or color), then you can use this function to access the Sign
Selection dialog.

Preview File  previews the currently selected file.

Most Recently Used  file list allows you to select one of the previous four files that have been worked on.

Exit  closes Vision Step2Sign Wizard.

Note that some of these selections become disabled within steps 2, 3 and 4.
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Open/Save/Save As

Whether you use Open, Save or Save As, the common File
Dialog will appear (shown to the right). The title and the
button will be named appropriately.

Note that all Vision Step2Sign Wizard schedule files have the
file extension of S2S.

 

 

 

Export Library

The purpose of this feature is to allow you to migrate from the
basic capabilities of the Wizard to the more advanced
features within Vision Edit, Vision Quick Text, and Vision
Schedule.

The export process will copy all message files within the S2S
folders into desired export folder. Group messages will not be
exported since they are only a combination of other
messages.

 

 

Preview

When selecting Preview for the first time, you will see the Video
Compression dialog. Although several “compressor” types may exist
on your computer, it is recommended that you use “Full Frames
(Uncompressed)”.

After selecting this the first time, the dialog will not be shown again.

 

 

 

When the Preview window opens, the message will
automatically start playing. You can move around the
message, pause it, and even save it (if needed). When you’re
finished previewing the message, simply press the Done
button to close the window.
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Exit

You can exit the application by one of two methods. First, you
can select “Exit” from the File menu. Second, you can press the
“X” (close) button at the top right of the application. In the
second case, a similar dialog as shown to the right appears to
ensure that you want to close. By purposely selecting the “Exit”
from the File menu, you can bypass this dialog.

 

 

EDIT MENU

The Edit menu gives you access to tools for managing your files and
schedule.

Create  allows you to create a New Message or a New Group.

Add Existing File  allows you to select and add previously created Vision
Edit or Vision Quick Text message files.

Edit a File  allows you to edit the currently selected file.

Delete a File  allows you to delete the currently selected file.

Schedule  allows you to add, remove, or move files within the schedule list.

Refresh Library  allows you to refresh the list of files shown in the various lists within Step 1.

Note that some of these selections become disabled within steps 2, 3, and 4.

Create a New Message

The Create a New Message window is a simplified version of
the Vision Quick Text application. You can only enter text and
you only have limited row control.

The text that is entered is automatically centered vertically.
You have control over the horizontal justification by selecting
the Left, Center, and Right buttons.

When entering text (inside the “Enter Text” control), you can
press “CTRL+ENTER” to add a new line of text. You do not
have row-by-row control as within Vision Quick Text.
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Font Selection

The font selection can be either “Raster Fonts” or “True
Type Fonts”. This is chosen from the Menu.

When “Raster Fonts” is chosen, the dialog shown on the
right will appear.

The fonts that are displayed are part of the raster font
database within the FONT subfolder where VisionSuite
was installed.

 

 

 

When “True Type Fonts” is chosen, the dialog shown on
the right will appear.

The fonts that are displayed are part of the True Type
Fonts that are installed on your computer. The listing of
fonts is controlled by Windows. For more information on
the installation and removal of Windows fonts, please
refer to your Windows documentation.

 

 

 

 

Effects Selection

When the “Select Effects” button is pressed, the dialog
shown on the right will appear.

The Effects Selection dialog allows you to control the ON,
HOLD, and OFF effects for this frame.

There are more than 50 effects to choose from. By
default, the selection is “CHANGE”, “HOLD”, and “NONE”
for the ON, HOLD, and OFF effects respectively.

Depending on the sign, the duration of the certain effects
can be altered. For the H20/H21 controller based signs,
both the ON and OFF effects have fixed durations.
However, in all cases, the HOLD effect’s duration can be
changed.
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When you double-click the mouse over the duration for
the HOLD effect, the “Enter Duration” dialog will appear.
You can control the effects time by seconds and
milliseconds. The fineness of this control is dependent
upon the sign’s controller and the select effect.

Once you’ve entered in a name for the new message, you
can press Save to save the file to the library.

The Message menu item allows for Saving and Previewing of the file.

 

 

The Font menu item allows for selecting Raster or True Type fonts and the
selection of the actual font. Select will show the appropriate font dialog for font
selection.

 

 

The Effects menu item allows for selection of Travel Mode and control of
normal Effects, Travel Options and Color control.

 

 

Travel Settings

The Travel Effect Settings dialog allows you to control the travel
speed and direction for a frame. The Travel Mode can be set or not
set per row. However, the speed and direction of travel is common
for all rows within the frame.

There are several predefined speed selections. These are
accessed by selecting “Normal Selection” and then choosing one of
the speeds within the pull-down list.

If you wish to set the speed to another value, then select “Advanced
Selection” and choose the distance of each travel step and the time
to hold the image at each step. The speed is shown as a guideline
to how fast the text will travel.
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Color Selection

When the color button is pressed, the Color Selection dialog will appear.
Press either button to select the color for text or the background color for
the current row.

 

 

 

When the sign is monochromatic (one color), the color selection is very
basic. The color selection dialog will show a list of colors
and the percentage of RED, GREEN, and BLUE used for
the color.

Shown to the right is the two color selection for a Red
Monochrome sign.

 

 

 

 

For a 16 Color LED sign, the number of available colors
increases. Correspondingly, the list grows.

The color selections do not necessarily represent the
exact colors that the sign will display. The exact colors
displayed may be slightly different due to the color
wavelength of the LEDs used within the sign.

Nevertheless, the selection is “representative” of the
colors that the sign will show.

 

 

 

The new 256-Shade signs have the capability of
displaying 256 unique shades.

You select the desired color by moving the mouse cursor
to the location on the horizontal color-bar and clicking the
mouse. You can also enter a value manually within the
Value control.

The control shown to the right is for an Amber sign with
256 shades.
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When your sign is a full color sign, the color selection is
vast. The color selection dialog, shown to the right, is the
standard Windows color selection. By default, there are
48 predefined colors, 16 custom colors, and 16+ million
other colors to select from.

The selection capability within this Windows dialog is
based on the color capability of your PC’s graphics card
and monitor. If you have a computer that only has 256
colors, this display will not be as extensive. Nevertheless,
it may be adequate for your sign.

It is recommended that your PC has full color capabilities
in order to have full color selection.

Create a New Group

When the window appears, you will have all the message
files within “Common Messages” and “Messages” lists shown
on the left of the window.

By pressing the right-arrow button, you can add a selected
file to the “New Group Files” list. Press the left-arrow button
to remove selected files from the group list.

Once a name is given to this new group of messages, you
can press the OK button to save the group.

 

 

Edit a File

When “Edit a File” is selected, either the “Create a New Message” or the
“Create a New Group of Messages” dialog will appear (with a different
window title).

The name of the file will not be able to be changed. Nevertheless, other
file attributes can be altered and the file saved.

Schedule

Add, Remove, Move Up and Move Down items are identical
to the four buttons in the middle of the Step 1 window.
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VIEW MENU

The View menu gives you access to various information.

Sign Parameters  displays the current information about the sign.

Sign Settings  display the some of the sign’s settings saved within Vision
Setup .

Sign Parameters

As shown on the right, the current settings of the ONLINE
sign are displayed. This is a much more detailed list of
information compared to the information shown in the main
window.

For more information on the setting up of a sign, please refer
to the main Vision Setup help.
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Sign Settings

As shown on the right, most of the basic information about
the sign is displayed. The information displayed is equivalent
to the information set when the sign was created in Vision
Setup.

For more information on the setting up of a sign, please refer
to the main Vision Setup help.

 

 

 

 

 

 

 

 

 

 

 

TOOLS MENU

The Tool menu gives you access to the following items.

Connect to Sign  allows the connection to an OFFLINE sign.

Disconnect from Sign  allows the disconnection from the current
ONLINE sign.

Admin Password  allows the entering of an Administrator
Password that has been setup within Vision Setup.

Hardware Password  allows the entering of the hardware
password for the sign. This value has also been setup in Vision Setup and saved to the sign.

Options  controls the options for this application .
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Admin or Hardware Passwords

If either the Admin or Hardware passwords are set, just press the
appropriate “Enter Password” button and the “Password Entry”
dialog will appear. The OK button remains disabled until a
password is entered. If the password is incorrect, an appropriate
message is displayed .

 

Options

The Options selections have been greatly enhanced from the
previous versions. The list on the left indicate all of the
sections of control that are available. The sections are the
following;

• General – Basic control of certain operational
features of the interface.

• Defaults – Basic control on settings for message
creation.

 

Options - General

The General section allows the following controls:

• Auto Load … – Automatically load the last saved
S2S file when starting the application.

• Auto Save … Exiting – Automatically save the
current S2S file upon exiting the application.

• Auto Save … Step 3 – Automatically save the
current schedule before going to Step 3. This will
make Step 2 invisible to the user.

• Show Sign Name … – Display the name of the
active sign within the title bar.

• Show Sign State … – Display whether-or-not the
sign is ONLINE or OFFLINE within the title bar.

• Show Schedule … – Display the name of the schedule within the title bar.

• Show Abbreviated … – Display an abbreviated version of the Time/Date Restriction within the
Schedule list in Step 1.

• Show “Success Render” … – Display a simple message showing that the new schedule has been
properly rendered for the current sign.
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Options - Defaults

The Defaults section allows the following settings for all
new Messages created within Vision Step2Sign:

• Rows – This control is grayed-out in order to
illustrate that Vision Step2Sign does NOT have
row control greater than 1 row.

• Colors – These indicators and the corresponding
button allow the control of colors.

• Font – Select between Raster and True Type
Fonts.

• Raster – Select the default Raster font.

• True Type – Select the default True Type Font.

• Travel – Select the travel speed.

• Effects – Select the effects (modes).

 

FAST KEYS

Below is a list of all of the acceleration keys for access to various features.

  CTRL+O Load a new schedule file.

  CTRL+S Save the current schedule file.

  CTRL+P Preview a selected file.

  

  CTRL+M Display the Create a New Message window

  CTRL+G Display the Create a New Group window

  CTRL+A Add a selected file to the schedule

  CTRL+X Remove a selected file from the schedule

  CTRL+Up Arrow Move item in schedule up one line

  CTRL+Down Arrow Move item in schedule down one line

  

  CTRL+SHIFT+V View the list of Sign Parameters

  

  CTRL+SHIFT+C Connect to the sign
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  CTRL+SHIFT+D Disconnect from the sign

TROUBLESHOOTING

When Vision Step2Sign Wizard steps to the Update Sig n step, it always shows that my sign is OFFLINE. Wh at
is wrong?

Several items could be wrong. Please refer to the “Troubleshooting” section within Vision Setup for more
information on this problem. .

Where do I enter my “Authorization Code”?

Entering your Authorization Code (in order to turn-off the “time left” display) is done within Vision Setup. For
more information, please refer to the main Vision Setup help.

The Time Left entry is showing “Expired” even though I know I have several days left before I need to en ter in
the Authorization Code.

The sign has not expired. You have set a “Hardware Password” and you have not yet entered it. Go to the
“Hardware Password” dialog and enter your password. Once completed, the time limit will display as expected.
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OVERVIEW

Vision Instant Message Lite is an application that allows a
user to update a DVI-Based LED Video Display. The
application allows one to configure two unique lists of media
files for instant viewing and a third list that will play
uninterrupted (schedule).

Vision Instant Message Lite is designed as simplified version
of Vision Instant Message PRO.

 

 

 

 

HOW VISION INSTANT MESSAGE LITE WORKS

When the computer is connected to our DVI-Based signage, Vision Instant Message Lite can be configured to display
an “image” (a playing media file) anywhere on the video card’s display area. Once configured, the user can then select
& play any file within the first two columns and play the whole list of files within the third column.

In normal operation, a user can either double-click on a media file or press the “Play” button beneath the file’s column.
The user can preview the file before playing it and even setup 2 unique files to display logos or default images.

The menu items give you access to various features to adjust the list of media files within the columns and the general
operation and appearance of the main window.

Vision Instant Message Lite (or PRO) provides an operator with the ability to play any media file quickly during a sports
event.
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OPENING VISION INSTANT MESSAGE LITE (FOR THE FIRST TIME)

When Vision Instant Message Lite (or Vision Viewer) is
opened for the first time, a majority of the application is
disabled. The installer or user must obtain an “Access Code”
(also referred to as the “Authorization Code” and “Activation
Code”).

Technical Support will step a user through the process of
saving the Installation Code and emailing it. Once received,
the Technician will email back an Access Code. Once
verified, the Access Code will activate the application and
give authorization to the user to use the features within the
application.

This activation may be time limited due to contractual
agreements.

 

THE MAIN WINDOW

The main Vision Instant Message Lite window has several
regions:

The Blanking the Display  region allows a user to choose a
type of image to “blank” the sign.

The Preview  region allows a user to preview a selected
media file.

The Time Limit  region at the bottom is an indication of “Time
Remaining” until the application is deactivated. If this region
is blank, there is no time limit in effect.

The Instant Message  region is composed of two columns of
user specified/selected media files.

The Schedule (or Loop) region contains the media files that can be played in succession.

At the top-portion of the window is the name of the current file playing.

Blanking the Display

The user can blank the sign with three different images. The standard BLACK SCREEN is
default and always available. Via the Options selection, the user can also specify two unique
BITMAP files. For example, these files could be logos or advertisements.
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Preview

This region allows a user to preview a selected media file. The media file can only be selected
within the Instant Message columns (the two left-most columns).

 

 

Time Limit (Access Code)

The Time Limit section displays the amount of time left before
the application stops working and an Access Code must be
entered.

Ten days  (and less) before the “time” expires, a message
box will appear whenever the user connects to the sign. Once
the time expires, the sign and software will no longer respond
to updates and the currently playing schedule/message will
stop being displayed.

Please see Vision Instant Message Lite - Installation for
information on entering an authorization code.

 

Instant Message

There are two columns available to the user to place media
files. Via the Edit menu selection, the user can add, delete,
and sort messages from the lists.

When enabled, the user can display a specific media file by
either;

• Double-clicking the mouse on the media file will
instantly play the media file once.

• Select the media file and then press the PLAY button
beneath the column. The Play button will allow the
entering of N iterations. The file will play N times.

The playing of a media file will be stopped if the user selects
another media file or presses Activate  for Blanking the
Display.

There is no limit to the number of files that can be placed
within the lists. However, it is recommended that number of
messages is kept to a manageable number.
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Schedule or Loop

The third column can be used to play a set of media files in a continuous loop.

The media files can be added, deleted, and sorted via the Edit Menu.

Once the PLAY  button is pressed, the other PLAY buttons are disabled. To STOP the
playing of the media files, one can either press the STOP button or press Activate  for
Blanking the Display.

There is no limit to the number of files that can be added to the list. The files are
played in succession and continuously (until stopped).

If one changes the list of media files for the schedule (or loop), one needs to “Generate
Loop Schedule” (see Edit Menu for more information).

 

 

 

 

 

FILE MENU

The File menu gives you access to one item.

Exit  closes Vision Instant Message Lite.

Exit

You can exit the application by one of two methods. First, you
can select “Exit” from the File menu. Second, you can press the
“X” (close) button at the top right of the application. In the
second case, a similar dialog as shown to the right appears to
ensure that you want to close. By purposely selecting the “Exit”
from the File menu, you can bypass this dialog.

 

 

EDIT MENU

The Edit menu gives you access to two items.

Manage Lists  will allow one to manage the media files contained
within the three lists.

Generate Loop Schedule  will generate a new schedule file for the
files contained within the LOOP list. Although this is automatically
done for the user each time the user presses the PLAY button, this menu selection is here so that more advanced
users can inspect the generated schedule file.
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Manage Lists

For each list of media files, the File Manager window will
allow for the adding, deleting, and sorting of files.

The Move Up  and Move Down  buttons allow one to sort the
media files into a particular order. This is useful when one
has many files. The most commonly used files can be kept to
the top of the list.

The Add  button allows one to add a new file; Delete  will
remove a selected file; and Edit  displays the “Media File
Parameters” dialog.

When adding a new file, one can add MPEG, AVI, BMP,
JPEG, and HTML files. Once selected, the “Media File
Parameters” dialog will appear to display certain information
about the file.

 

 

Media File Parameters

This dialog displays the location of a file, the type of file, and
its duration. Obviously, changing the duration will affect how
long the file is displayed. Bitmap files have a default time
duration set within the Options window. Movie or Animation
files are automatically determined from the media file itself.

 

 

 

 

TOOLS MENU

The Tools menu gives you access to the following item:

Options  – Control the options for this application.



Vision Instant Message Lite VisionSuite User Manual

126 Version 3.1

Options

The Options selections have been greatly enhanced from the
previous versions. The list on the left indicate all of the
sections of control that are available.

The sections are the following;

• General – Basic control of certain operational
features of the interface.

• Main Window – Basic control on the look and feel of
the main window.

• Text Format – Control on how media files are
referenced within the application.

• Content Player – Control the location of the content
player on the video card display.

• Installation – Control on the Installation Code and Access Code for application Authorization (also referred to
as the “Authorization Code”).

Options - General

The General section allows the following controls;

• Disable the double-click operation within the Instant
Message columns (A & B).

• The default reference time for any BMP, JPEG, and
HTML files added to a column. The value can be
over-ridden when adding the file (refer to Media File
Parameters).

• The Play button at the bottom of columns A and B
can either automatically play the selected file once or
allow the user to enter in a number of iterations.

• When media file is playing, the complete pathname
can be shown.

Options - Main Window

The Main Window section allows the following controls;

• One can enter in a specific heading for all three
columns.

• One can select two BMP files for displaying as a
“Blanking” image. Within the Main Window you can
select between BLACK and the two files.
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Options - Text Format

The Text Format section allows the following controls;

• Basic – This will force a predefined format for all files.
The format is the file name and extension. (e.g.
filename.ext)

• Custom – This will allow one to control what is
displayed. The file name is always displayed. One
can select from the following: Show the file
extension, Show the file type, Show the file duration
in seconds, Show the name in capitals.

 

Options - Content Player

The Content Player section allows one to enter in the exact
location on the PC computer screen where the “content
player” will be located.

This location will be used by the DVI-Based video system to
show the media files onto the sign.

 

 

 

 

Options - Installation
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The Installation section shows the Installation and Activation
codes. The activation (or “access”) code provides unlimited or
time limited access to the display of the media files.

The “…” button next to the Installation Code allows one to
SAVE the Installation Code.

The “…” button next to the Activation Code allows one to
LOAD the Activation Code.

The process of Loading the Activation Code is as follows:

• Save the Installation Code and send it to Technical
Support. They will generate an “Activation” code for
you.

• Upon receiving the code file, load the Activation
Code file.

• Press the “Verify” button.

One of the two messages, shown to the right, will appear
once the code has been verified.

FAST KEYS

Below is a list of all of the acceleration keys for access to various features.

  F1 HTML Help File.
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INTRODUCTION

Vision DVD is an application that allows a user to play a DVD on a DVI-Based LED Video Display (DVI stands for
"Digital Video Interface", a type of port used to connect video displays to computers). It requires a computer with a
DVD drive and an available DVI port. The application allows one to specify two different areas of the screen on which
to display the DVD content. This allows, for example, one to preview/cue a DVD on the computer monitor before
displaying on the remote LED display.

GENERAL USE

To use Vision DVD, the host computer must be capable of driving two monitors, for
example, a desktop computer with two monitor ports or a laptop computer with an
external monitor port. The LED Video Display is connected to the second monitor
port.

 

 

When a computer has two monitors connected, there are a
few basic ways to setup what gets shown on each monitor:

1. the entire display can be spread across monitor 1
and monitor 2

2. monitor 2 can be set to mirror monitor 1

3. monitor 2 can be treated as a separate display

When using Vision DVD, monitor 1 and monitor 2 must be
setup in either configuration 1 or 2 above.

Vision DVD allows video to be displayed in one of two
locations: Location 1  and Location 2 . Location 1  is where the DVD is cued and previewed. Location 2  maps to
where the video is played on the LED Video Display.

Once the locations have been setup, the user can control the DVD using the buttons located on the bottom right-hand
side of the application. The buttons mimic those found on traditional DVD remote controls, e.g., PLAY , PAUSE, and
STOP.

SETTING THE VALUES FOR LOCATION 1 AND LOCATION 2

The values for Location 1  and Location 2  depend upon how the two monitors are setup:
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The Display is Spread Across both Monitors

When the display is spread across both monitors, the
LED Video Display will be situated to the right of the
computer monitor. Therefore, if the computer monitor
has a resolution of 1024x768, the upper left-hand
corner of the LED Video Display will be mapped to the
'x' and 'y' co-ordinates of '1024' and '0'.

Assuming, then, that the resoution of the computer
monitor is 1024x768, complete the following steps:

1. Select Options  from the Tools  menu

2. Enter a value of 0 for both X Offset  and Y
Offset  under Location 1

3. Enter a value of 100 for both Width  and
Height  under Location 1

4. Enter a value of 1024 for X Offset  under
Location 2

5. Enter a value of 0 for Y Offset  under
Location 2

6. Enter the width in pixels of the LED Video Display for Width  under Location 2

7. Enter the height in pixels of the LED Video Display for Height  under Location 2

8. Press OK

Location 1  (the location for previewing/cueing) will now be at the top left-hand corner of the computer monitor.
Location 2  (the location for the actual LED Video Display) will be setup in the correct position, i.e., to the right
of the computer monitor.

Now, when Location 1  is selected, the DVD will play in the upper left-hand corner of the computer monitor.
When Location 2  is selected, the DVD will play on the LED Video Display.

Note: Since the entire display is spread across both monitor 1 and 2, if the mouse is moved all the way to the
right, it might appear on the LED Video Display
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Monitor 2 Mirrors Monitor 1

When monitor 2 mirrors monitor 1, the LED Video
Display mirrors what is displayed on the upper left-
hand corner of the computer monitor.

Therefore, complete the following steps:

Change the background color of the desktop to black if
the LED Video Display must be blank when no DVD is
playing (recommended)

1. Select Options  from the Tools  menu

2. Enter a value of 0 for both X Offset  and Y
Offset  under Location 2

3. Enter the width in pixels of the LED Video
Display for Width  under Location 2

4. Enter the height in pixels of the LED Video
Display for Height  under Location 2

5. Enter values for X Offset  and Y Offset  under
Location 1  such that they do not interfere with
the position of either the Vision DVD  program or Location 2

6. Press OK

Now, when Location 1  is selected (the location for previewing/cueing), the DVD will play in a "safe" area of the
main display. When Location 2  is selected (the location for the actual LED Video Display), the DVD will play in
the upper left-hand corner of the main display. This is the correct position for the "mirrored" LED Video
Display.

Note: If the mouse or any other window is moved into the area occupied by Location 2  (the location of the
external display), the image of the mouse or window will appear on the LED Video Display.

MENU ITEMS

File

Exit  - exits the Vision DVD.

View

Render Status Info  - displays technical information about the DVD device present on the PC. Used mainly for
technical support purposes.

Tools

Options  - sets the default settings for Vision DVD.

Location 1  - sets the location and size of Location 1 . See General Use  above.

Location 2  - sets the location and size of Location 2 . See General Use  above.

Defaults/Location  - sets the initial location where video is played when Vision DVD launches.
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Defaults/DVD Drive  - selects the drive letter of the DVD drive.

Help

Contents  - launches the Vision Suite help system.

About  - displays information about Vision Suite.

DVD CONTROLS

Play

[] Stop

|| Pause

<< Rewind

Fast Forward

|< Previous Chapter

| Next Chapter

L Mark Loop Start/End
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INTRODUCTION

Vision File Converter is an application that converts rendered
MSG files into VED files. The resulting files can be edited in
Vision Edit.

 

 

 

 

 

 

 

SINGLE FILE CONVERSION

To convert a single MSG file, select MSG to VED: Single
File Conversion  and press Next to continue.
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In the Source File  area of the dialog box, pressing ... will
bring up the standard Windows Open File  dialog box. Select
the desired source file and press OK. The Width , Height ,
and Color  values are set according to the properties of the
source file.

In the Destination File  area of the dialog box, pressing ... will
bring up the standard Windows Open File  dialog box. Select
or enter the name of the desired destination file and press
OK. The Width , Height , and Color  values are set according
to the properties of the selected source file.

Press Next to convert the selected file.

 

The program will then proceed to convert the selected file.
The Status  region will display information related to the
conversion process. When the file has been converted,
DONE!!  will be displayed on the bottom of the dialog. Press
Exit  to exit the program.

 

 

 

 

 

 

MULTIPLE FILE CONVERSION

Vision File Converter can convert all MSG files in a single
directory to VED files. To convert multiple files, select MSG
to VED: Multiple Files - Folder Conversion  and press Next
to continue.
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In the Source Folder  area of the dialog box, pressing ... will
bring up the standard Windows Select Folder  dialog box.
Select the desired source folder that contains the MSG files
that are to be converted and press OK.

In the Destination Folder  area of the dialog box, pressing ...
will bring up the standard Windows Select Folder  dialog box.
Select or enter the name of the desired destination folder
where the converted VED files will go and press OK.

Press Next to convert the files in the selected folder.

 

 

The program will then proceed to convert the files. The
Status  region will display information related to the
conversion process. When the files have been converted,
DONE!!  will be displayed on the bottom of the dialog. Press
Exit  to exit the program.
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INTRODUCTION

Vision Quick Text Converter is an application that converts
old-format VMG files to new-format VMG files. In the process
of conversion, attributes such as width, height, and color can
be changed. As well, the program can convert new-format
VMG files to new-format VMG files with changed width,
height, and color attributes.

 

 

 

 

 

 

 

CONVERTING A FILE

To select the VMG file to be converted, press ... in the
Source File  area of the dialog box. This will bring up the
standard Windows Open File  dialog box. Select the file to be
converted and press OK.
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SETTING THE DESTINATION FILE AND ATTRIBUTES

Naming the Destination File

Vision Quick Text Converter can automatically name the
destination file. If this is desired, select Use Auto Named
Destination File  under the Selection  menu. A checkmark
beside this menu item will indicate that this option is selected.
The file will be saved in the same folder as the source file.

To specify the name and location of the destination file,
deselect Use Auto Named Destination File  under the
Selection  menu. If there is no checkmark beside this menu
item, this will indicate that the option is deselected. Pressing
... will bring up the standard Windows Save File  dialog box.
Specify the name and location of the destination file and
press OK.

Specifying the Attributes of the Destination File

Vision Quick Text Converter can automatically specify the
attributes of the destination file based upon sign-type. If this
is desired, select Use Sign Definition File  under the
Selection  menu. A checkmark beside this menu item will
indicate that this option is selected. Next, select Select Sign
from the Selection  menu. The standard VisionSuite Sign
Selection  dialog will appear. Select the sign with the desired
width, height, and color attributes and press Select .

To specify the width, height, and color attributes of the
destination file, deslect Use Sign Definition File  under the
Selection  menu. If there is no checkmark beside this menu
item, this will indicate that the option is deselected. Enter the
desired width and height in the appropriate places and select
a color from the available selections.

CONVERTING THE FILE

Press Convert  to convert the file. Upon completion a dialog
will be displayed indicating the name and location of the
converted file. Press OK to dismiss the dialog. Another
conversion can be performed, if desired.
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EXITING

To exit from Vision Quick Text Converter, select Exit  from the File  menu or press the x button in the upper-right hand
corner of the dialog.
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INTRODUCTION

Using Vision Server, a number of remote computers connected via a network or modem can send media files for
display on a single Video System. For more information on how to set up such a configuration, please see VisionPRO
Systems and Updating Content Remotely.

VISION SERVER REFERENCE

Main Dialog

Status

The status area displays status messages relating to
server activities.

Clear List

Clears the status messages

Start Server

Starts the server. Note, that depending upon various
options (described later), the server may already be
started upon program launch.

File Menu

Exit

Exits Vision Server

 

Tools Menu

Options
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General

Start Server-Listening at Start-up.

Automatically starts the server when the Vision
Server is launched. This is equivalent to pressing
the Start Server  button.

Minimize Application at Start-up.

Automatically minimizes Vision Server when the
program is launched.

Launch Vision Viewer at Start-up.

Automatically starts Vision Viewer when Vision
Server is launched.

Network Settings

Router Port Settings

The port on which Vision Server listens for
incoming messages.

 

 

 

 

Security

Administration Password

This is used to set a password so that all Vision
Server operations are password-protected. To
set a password, check the box and click the ...
button. Enter a password, press tab, enter it
again, then press OK. To cancel, press Cancel .
Exit and relaunch Vision Server for password-
protection to be in effect. It is recommended to
set a password!

IP Access List

To restrict access to requests from specific IP
address, check the box and click Add  to add an
IP address. To delete an IP address, select the
address and press Delete . It is highly  recommended to restrict access to only specific IP address!
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Maintenance

Log Network Communciations

This is used to log network communications for
troubleshooting purposes.

View Log

If logging has been enabled, press this to view
the log.

Delete Log

If a log exists, press this to delete the log.
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INTRODUCTION

Vision Viewer is an application that plays scheduled AVI, MPEG, and BMP files on a Video System. It is used in
conjuction with Vision Server, Vision Viewer Updater, or a program such as Symantec pcAnywhere. For more
information on setting up a Video System, please see VisionPRO Systems and Updating Content Remotely.

INSTALLATION AND ACTIVATION

To install and activate Vision Server, please see the example Entering an Authorization Code

ADDING A NEW LAYOUT

In order to play content on a video system using Vision Viewer, a Layout and Content Player must be created. Please
see the example Setting up a Content Player for more information.

VISION VIEWER REFERENCE

Main Dialog

Settings Area

The area on the left of the main dialog displays the
settings for the current Content Player Layout.

Content Player Area

The area on the right of the main dialog displays the
settings for the selected Content Player. The drop-down
list is used to select the Content Player.

Play/Stop

This button is used to play and stop the content. If it is
greyed-out, the software needs to be activated. Please
see "Installation and Activation" above.

Show/Hide

This button is used to show and hide the content. If it is greyed-out, the software needs to be activated. Please
see "Installation and Activation" above.
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File Menu

Exit

Exits Vision Viewer

Tools Menu

Options

General

Show Content Player Layout Name in Title Bar

If this is selected, the name of the currently selected
Content Player is displayed in the Title Bar of the
program.

Minimize Application at Start-up

If this is selected, when Vision Viewer is started, it
will be automatically minimized.

Content Players

Layouts Drop-Down List

Selects the current Content Player Layout. Checking
the box sets the current Layout as the default. The
attributes of the currently selected layout are listed
underneath the drop-down list.

Add

Adds a new layout. See "Adding a New Layout"
above for more details

Edit

Edits the currently selected layout.

Delete

Deletes the currently selected layout.
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File Transfers

Enable File Transfer Feature

Allows Vision Viewer to refresh the content from files
transferred via a remote PC running a program such
as pcAnywhere.

File Transfer Location

Sets the location where transferred files are stored.

Optimize Hard Drive Space

Optimizes the space taken up by the transferred files.

Installation

Please see the example Entering an Authorization Code
for more information.

 

 

 

 

 

 

Advanced

Launch DVI Setup Application

This launches the Vision DVI-LINK Utility.

Launch Video Tester

This launches the Vision Video Tester Utility.
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INTRODUCTION

Vision Viewer Updater is used to update content on a Sign
PC (Video System) running Vision Server and Vision Viewer.
For more information on setting up a Video System, please
see VisionPRO Systems and Updating Content Remotely.

 

 

 

 

 

 

 

 

SETTING UP VISION VIEWER UPDATER

For information on setting up Vision Viewer Updater, please see the example Setting up Vision Viewer Updater.

VISION VIEWER UPDATER REFERENCE

Main Dialog

Send  - Sends the content ot the Sign PC.
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File Menu

Exit  - Exits Vision Viewer Updater

View Menu

Viewer Status  - Views the status of the Sign PC.

Viewer Layouts  - Views the Vision Viewer Layouts
available on the Sign PC.

Tools

Convert Schedule  - Converts a schedule created by
Vision Schedule to a format usable by Vision Viewer.

Connect to Vision Server  - Connects to Vision Server
running on the Sign PC.

Disconnect to Vision Server  - Disconnects from Vision
Server running on the Sign PC.

Start Vision Viewer Layout  - Starts content playing on the Sign PC using the currently selected Vision Viewer
Layout.

Stop Vision Viewer Layout  - Stops content playing on the Sign PC.

Options

General

Auto-connect to Vision Server at start-up.

Automatically connects to Vision Server running
on the Sign PC when the program is launched.

Auto-select Layout when there is only one.

When there is only one Layout available in Vision
Viewer on the Sign PC, selects this Layout.

Auto-stop the playing of media during an update.

When the content is updated by pressing "Send",
stops Vision Viewer on the Sign PC from playing
content.
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Network

IP Address

The IP Address of the Sign PC.

Router Port

The port on the Sign PC on which Vision Server
listens for incoming messages.

 

 

Folders

Export Folder

The folder where Vision Schedule places a
schedule and content.

Folder Type

Either Single or Multiple Content Players.
Currently only one Content Player per Vision
Viewer Layout is supported.

Secure file transmission.

Currently not supported.

Unsecure file copy.

Copies content files to the Sign PC as they are.

Destination Folder

The folder where content is copied to on the Sign PC.
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OVERVIEW

As the world of technology changes, so does the demand placed on computers. VisionSuite is no exception.
VisionSuite has many more capabilities than the previous version of software that have allowed users to edit
messages and control signs. To this end, VisionSuite requires more computer capabilities than previous generations.

REQUIREMENTS

The VisionSuite applications have been developed for systems with the following configurations:

  Windows™ Operating System Windows 2000-SP4 / XP (Pro/Home) – SP2 / Vista - SP1

  Processor Pentium IV (or Better)

  RAM 256 MB (minimum)

  Hard Drive Space 40 MB (minimum)

  Video Card 24-bit Color (minimum) for Message Centers
32-bit Color (minimum) for Video Systems

  Video Resolution 800 x 600 (minimum)

  I/O Standard Serial port for Message Centers
Extra DVI port on video card for new Video Systems
PCI-2 card for older Video Systems

  Standard Components Mouse, Keyboard, Color Monitor, CD-ROM, and Floppy Drive

The more complex the image file handling that has to be performed, the more advanced the computer system must be
for any realistic performance.

Although any computer running a modern operating system may work, it is always recommended that you contact your
sales representative to obtain up-to-date information on computer and operating system compatibility.

WINDOWS VERSIONS

VisionSuite is designed to work on the following operating systems:

• Windows Vista with SP1

• Windows XP Home and Pro

• Windows 2000
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ADDITIONAL INFORMATION

Requirements for VisionSuite can change. It is recommended to consult your Sales or Service Representative for the
latest information.
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FOLDER STRUCTURE OF VISIONSUITE

When VisionSuite is installed with to its default folder (C:\HDD), the following folder structure will exist.

C:\HDD

\ASSETS
\CommTests
\EXPORT
\FONTS
\HELPDOCS
\INI
\Logs
\MESSAGES
\OS
\SIGNDESC
\S2S
\TEMP
\VIM

The ASSETS folder contains interim files for older Video systems for backward compatibility.

The CommTests  folder contains the archived communication test results. An option must be set within Vision Setup
for the files to appear within this folder.

The EXPORT folder will eventually contain subfolders whose names are the names of your signs. Within these
subfolders, Vision Schedule will export the schedule and messages for a given sign.

The FONTS folder contains the Raster Fonts (from HDD) for your text message creation.

The HELPDOCS folder contains all of the HTML files that compose the Help and Tutorial system.

The INI folder contains all of the initialization files for the main applications.

The Logs  folder contains one or more log files. An option must be set within Vision Setup for the file(s) to appear
within this folder.

The MESSAGES folder is initially created for you to place your new VED, VMG, and VSF files (created from Vision
Edit, Vision Quick Text, and Vision Schedule, respectively). This folder is made for you convenience. You may store
your files anywhere.

The OS folder is the location where the sign’s operating system image files are stored.

The SIGNDESC folder contains two types of files: your sign description (or definition) files and a small data base for
color references for the various sign types. The sign description files are denoted with a file extension of INI.

The S2S folder contains the files and folders for the Vision Step2Sign Wizard application.
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The TEMP folder is a “scratch” folder for VisionSuite. The folder can contain various files depending upon the
application that writes to (or reads from) this folder. You should not place anything into this folder since its contents are
considered to be temporary and can be deleted at any time.

WARNING: Do not use the C:\HDD\TEMP folder to store your files. The folder’s contents can be deleted at
any time.

The VIM folder contains the files and folders for the Vision Instant Message application. A specialized library of files is
created within the VIM folder when messages are added or created within the application.

USING THE H1020 SOFTWARE ON A WINXP COMPUTER

One of the many reasons for developing the new VisionSuite was to create a suite of applications that would be fully
Windows™ compatible. The older H1020 software was originally developed for the DOS environment. The newer
Windows operating systems (Win2k/WinXP) have a different communication port control methodology than within DOS
or Win95/98. In the newer versions of Windows, the operating system can take control of the various communication
ports (i.e. the serial and parallel ports) in order to maintain system integrity (on various levels). The H1020 software
was never designed for this scenario and cannot connect to the signs.

In addition, there are also various graphics issues that can interfere with the proper operation of the H1020 software.
These can be numerous and are beyond the scope of this topic.

However, there is a way to connect to a sign and use the old H1020 software while using your WinXP computer (for
example). If you reboot your computer with a DOS diskette, you should be able to run the old H1020 software directly
from a diskette. This process will bypass the entire Windows operating system.

The process is the following;

• Create a DOS bootable diskette.

• Copy the H1020 software from the CD onto another diskette.

• Place the DOS bootable diskette into the floppy drive and reboot the PC.

• Once at the DOS prompt, place the H1020 diskette into the floppy drive.

• Run the MOUSE batch file by typing MOUSE and then pressing enter.

• Run the main H1020 application by typing H10MAIN and then pressing enter.

• Use the H1020 software as you have done in the past.

There are several items that might interfere with this process.

• If you have a unique monitor or video card that requires advanced Windows drivers to work properly, then this
process might not work for you.

• You need to store your messages on the floppy diskette. If you have too many messages (or too large) for the
floppy, then this process might not work for you.

• If you have a newer sign system that is not supported with the old H1020 software, then this process might not
work for you.
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EXTRAS ON THE CD

With the installation CD, there are several extra items that have been included. On the CD, you will notice the following
folder (and subfolder) structure.

D:\Extras

\H1020
\Library
\PDF Manual

The H1020 folder contains a copy for the old H1020 software suite for communication to all older sign systems that are
not longer supported in the new VisionSuite.

NOTE: The older H1020 software will not communicate with newer electronic control devices (e.g. H22, DVI-
LINK, and VPU based signage).

The Library  folder contains a set of pre-created files for your use in making messages.

The PDF Manual  folder contains the latest manuals for VisionSuite in PDF format.

USB CONNECTION TO MESSAGE SIGNS

In a few situations, you may not have a serial port in your computer. Instead, you may only have USB ports. (Note:
This can be quite common on mid-high performance laptops.)

You can connect to a standard H21-based message sign via a USB port by using a USB-RS232 converter. Many
manufacturers for these converter devices exist. They can be purchased from a wide variety of computer stores. The
device normally comes with a Windows driver.

Simply connect the USB-RS232 device to the USB port on your computer. Windows should automatically see the
device and ask for a driver. After the USB-RS232 converter has been installed, go to the Device Manager and
determine the COM port  the USB device references. Go to Vision Setup and change the serial port to the appropriate
COM port.

USB-RS485 converters work in the same manner.

MODEM COMMUNICATIONS

Within Windows, there are two methods of connecting to modems (either internal or external versions): use AT
commands or Windows’ TAPI method. The VisionSuite 2.1 (and greater) applications now allow for both modes.

The TAPI method depends greatly on the version of Windows and the modem being used. The AT command method
requires extensive knowledge of the modem’s internal AT commands and is a more low-level approach to the modem
communications.

Due to the various modems available and backward compatibility issues, it was decided to implement both modes.
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The following is the list of current error messages that could occur during communications to the sign. Possible
reasons are also noted when appropriate.

MOST COMMON ERROR

31000 Maximum number of reattempts has exceeded.

Possible Reason: The most common reason for this error occurs when the connection between the PC and the sign
has been interrupted. The sign has either been powered off, the connection is down (or broken, or powered off), or the
sign’s electronics are not responding.

GENERAL ERRORS

21002 CRC verification failed.

Possible Reason: The connection to the sign has dropped due to a poor connection with a modem or cell phone. For
direct-connect systems, the cable may have been damaged and might require replacing.

21003 Invalid data structure.

Possible Reason: An older version of the software is being used with a newer communications DLL. A reinstall of the
software should resolve this problem.

21004 Data structure has an invalid size.

Possible Reasons: An older version of the software is being used with a newer communications DLL. A reinstall of the
software should resolve this problem.

The Hardware Password that you have entered is incorrect and all subsequent communications between the sign and
the PC will generate this error message. You are trying to CLEAR your old Hardware Password. However, you have
not yet SET your current Password. Enter the current Hardware Password and then return to the Password dialog to
CLEAR the set password.

21005 Unsupported data structure.

Possible Reason: An older version of the software is being used with a newer communications DLL. A reinstall of the
software should resolve this problem.

21006 Invalid header structure.

Possible Reason: An older version of the software is being used with a newer communications DLL. A reinstall of the
software should resolve this problem.

21007 One or more arguments are invalid.

Possible Reason: An older version of the software is being used with a newer communications DLL or the access to
the DLL does not match with the current design. A reinstall of the software should resolve this problem.
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22000 General negative acknowledgement.

MODEM: TAPI COMMUNICATION ERRORS

21203 Unable to allocate memory for the TAPI process.

21300 No Modem

21301 No TAPI registered devices available.

21302 TAPI device is not available.

21303 TAPI connection is not available.

21304 TAPI Communication Event translation error.

21305 TAPI Communication Read error.

21306 TAPI Communication Write error.

21307 Windows Modem Communications Dialog is not available.

21308 TAPI thread has not been created.

21309 The TAPI's selected line doesn't support VOICE and/or DATA capabilities.

21310 The TAPI's selected line doesn't support DATA MODEM and/or DIGITAL DATA capabilities.

21311 Unknown error occurred during TAPI initialization.

21312 Error on TAPI Requested line.

21313 Line is already in use by a non-TAPI application or by another TAPI Service Provider.

21314 Cannot use TAPI device. Unable to use Line.

21315 lineDeallocateCall unhandled error.

21316 lineClose unhandled error.

21317 lineGetTranslateCaps unhandled error.

21318 lineGetCountry unhandled error.

21319 The values in the INI file are invalid.

21320 There is a problem with your Telephony device driver.

21321 Reinitialize Connection - Shutting Down TAPI.

21322 Remove one of your copies of your Telephony driver.

21323 Out of memory. Canceling action.

21324 The TAPI operation failed.

21325 A TAPI resource is unavailable at this time.

21326 LINE CALLSTATE: Unknown device ID



User Manual VisionSuite Appendix III – Error Codes

Version 3.1 161

21327 Unhandled LINECALLSTATE message.

21328 lineGetDevCaps unhandled error

21329 LocalAlloc failed in CheckAndReAllocBuffer.

21330 LocalSize returned 0 in CheckAndReAllocBuffer.

21331 lineGetAddressCaps unhandled error.

21332 lineMakeCall unhandled error.

21333 lineDial unhandled error.

21334 lineTranslateAddress unhandled error.

21335 lineGetID unhandled error.

21336 lineShutdown unhandled error.

Possible Reason: These set of errors indicate a problem with the modem device. Ensure that the modem is TAPI
compliant (or Windows 2000/XP compliant) and that it has been installed properly. Go to the Windows’ Control Panel
and test the modem. If communications does not occur reliably, then either the modem does not work properly or the
driver for the modem does not work properly under the version of Windows that you are using. Contact the modem
manufacturer (or reseller) for assistance.

MODEM:AT-COMMAND COMMUNICATION ERRORS

21400 Unknown/unsupported error from the modem communications.

Possible Reason: Either the modem or the connection to the sign has produced an error that is not supported. The
most common reason for this error occurs when the modem at the PC is not working properly.

21401 No carrier detected.

Possible Reason: The most common reason for this error occurs when the phone line connected to the modem at the
PC is not working properly.

21402 No dial tone detected.

Possible Reason: The most common reason for this error occurs when the phone line connected to the modem at the
PC is not working properly.

21403 No answer.

Possible Reason: The most common reasons for this error are:

• the modem at the sign is not functioning properly,

• the phone line to the sign is not working properly,

• the sign’s electronic controller is not working properly, or

• the sign is powered off.

21404 Busy signal received.
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Possible Reason: The most common reason for this error occurs when someone else is already connected to the sign.

21405 General communications error.

Possible Reason: This is a general error that occurs when the modem at the PC is not working properly. It is a very
rare error.

21406 Connection attempt to sign has timed out.

Possible Reason: The most common reason for this error occurs when modem at the sign is not picking up. This is
either a sign that the modem is damaged or that the phone line to the modem Is damaged.

21410 Modem is not responding.

Possible Reason: The most common reason for this error occurs when the modem at the PC is not turned on.

H21 SPECIFIC COMMUNICATION ERRORS

22001 Invalid password. (NAK)

22002 File not found. (NAK)

22003 File Memory is FULL. (NAK)

22004 Requested file is in use. (NAK)

22005 Sign is running. (NAK)

22006 Sign is stopped. (NAK)

22007 Requested command is not supported. (NAK)

22008 Transmitted data is invalid. (NAK)

22009 No files exist on the controller. (NAK)

22010 Remote system is busy. (NAK)

22011 File already exists. (NAK)

22012 Authorization password is invalid. (NAK)

22013 Requested sign number is not supported. (NAK)

22014 Transmission packet is corrupt. (NAK)

Possible Reason: These set of errors are generated by the controller within the sign. These errors can occur for a wide
range of issues. If any of these errors occur, you may wish to contact Technical Support for further information and
assistance.

H22-SPECIFIC COMMUNICATION ERRORS

23001 CRC error within the header.

23002 CRC error within the data block.

23003 Invalid command.
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23004 Invalid data.

23005 Invalid sign number.

23006 Invalid password.

23007 Invalid authorization.

23008 Sign is busy.

23009 Sign is inactive.

23010 Command is not complete.

23011 Invalid memory.

23020 Bad packet sequence.

23021 Bad address.

23022 Memory is full.

23023 Transmission is too large.

23024 Multi-packet is not complete.

23025 Invalid version number.

23040 Software general error.

23060 Test of flash has failed.

23061 Test of RAM has failed.

23062 Access to the FPGA has failed.

23063 Temperature / Photocell probe is not responding properly.

23064 DIP switch read error has occurred.

23080 General FPGA hardware error.

23100 File CRC error.

23101 File name is invalid.

23102 No space for file to be stored into memory.

23103 File deletion failed.

23104 File system failure.

23105 File not found.

23106 File in use.

23107 File already exists.

23108 File size is invalid.
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Possible Reason: These set of errors are generated by the controller within the sign. These errors can occur for a wide
range of issues. If any of these errors occur, you may wish to contact Technical Support for further information and
assistance.

GENERAL OPERATIONAL ERRORS

27000 Invalid password within verification process.

Possible Reason: This is a highly unusual error and indicates that VisionSuite and communications to the sign are not
compatible.

GENERAL DATA TRANSMISSIONERRORS

28000 Write buffer is too large.

28001 Read process is taking too much time.

Possible Reason: These set of errors are generated by the controller within the sign. These errors usually indicate that
VisionSuite and communications to the sign are not responding properly. If any of these errors occur, you may wish to
contact Technical Support for further information and assistance.

GENERAL FILE ERRORS (AT THE PC)

29000 File could not be found within the system.

29001 File does not have read permission.

29002 Error occurred while trying to read the file.

29003 File does not have write permission.

29004 Error occurred while trying to write the file.

29005 Invalid file type.

29006 File information is not available.

Possible Reason: These set of errors are usually generated within VisionSuite applications when the user tries to
access files on the PC that are not accessible by the user. This may be an indication that the user needs special file
access permissions in order to use the files.

SERIOUS ERRORS

30000 General serious error.

30001 Cannot create an application thread.

30002 Connection exists to device.

30003 Invalid thread version.

30004 Invalid communication type; not supported within the software.

30005 Invalid device mask; not supported within the software.
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30006 Communications Thread cannot terminate due to unexpected Windows operation.

30007 Invalid operation code generated.

30008 Write request has exceeded parameter limits.

30200 Unable to create handle.

30201 Unable to access Windows communication state for serial port.

30202 Unable to set Windows communication state for serial port.

30203 Unable to set Windows communications buffer for serial port.

30204 Unable to set Windows communication timing device for serial port.

30205 Unable to close handle.

30308 Unable to create TAPI device thread.

Possible Reason: This set of errors are serious errors and usually indicate that the PC and Windows is not working
properly. If any of these errors occur, contact your local IT Personnel for immediate computer assistance.

WINDOWS™ GENERATED ERRORS

The error numbers returned (shown) are greater than ZERO. The following represent the most likely errors returned by
Windows.

32 The process cannot access the file because it is being used by another process.

Possible Reason: This can be returned when a file is being accessed by more than one user or application.

87 The parameter is incorrect.

Possible Reason: This can be returned when the serial port communications within Windows has been set to an “odd”
state. Simply reboot the PC and the problem should disappear. If the problem persists, please contact Technical
Support for assistance.


